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Before you Begin

Welcome to the COMSOL Multiphysics Installation Guide, which provides 
instructions on how to install COMSOL Multiphysics® and its add-on products. 
In addition to this manual, several on-line resources are available which are 
relevant for installation:
• System Requirements: www.comsol.com/system-requirements
• Support Knowledge Base: www.comsol.com/support/knowledgebase
• Support Center: www.comsol.com/support
• COMSOL Software License Agreement: 

www.comsol.com/comsol-license-agreement
• Product Download: www.comsol.com/product-download
• Product Updates: www.comsol.com/support/updates
• COMSOL Video Gallery: www.comsol.com/video

Instal lation Media Options

There are four installation media options for COMSOL 5.3:
• Installation over the Internet:

- This option requires Internet access from the computer where COMSOL is 
to be installed.

• Installation from a downloaded DVD image:
- This option requires Internet access from any computer for downloading the 

DVD image file with an .iso file extension.

• Installation from a DVD given to you by a COMSOL representative:
- This option requires access to a DVD reader on the computer where 

COMSOL Multiphysics is to be installed.

• Installation from a USB Flash Drive given to you by a COMSOL 
representative:
- This option requires a USB port on the computer where COMSOL is to be 

installed.

Installation using any of these four options is explained later in this document.
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System Requirements

COMSOL Multiphysics is a cross-platform software that runs on the Windows®, 
macOS, and Linux® operating systems. A variety of hardware platforms are 
supported, including graphics cards. Before installing, make sure your computer 
meets the current system requirements listed at: 
www.comsol.com/system-requirements.
There is also a current list of compatible software versions for:
• External function C compiler
• COMSOL API when used with Java®

• LiveLink™ for MATLAB®

• LiveLink™ for Excel®

• CAD Import Module
• Design Module
• LiveLink™ for SOLIDWORKS®

• LiveLink™ for Inventor®

• LiveLink™ for AutoCAD®

• LiveLink™ for Revit®

• LiveLink™ for PTC® Creo®Parametric™
• LiveLink™ for PTC®Pro/ENGINEER®

• LiveLink™ for Solid Edge®

• File Import for CATIA® V5

Previous Instal lations

Previous installations of COMSOL on your computer are not affected by your 
new COMSOL 5.3 installation except that double-clicking a Model MPH-file 
opens in the latest installation (unless otherwise specified during installation). You 
10 | 
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can continue to use other versions or uninstall them independently of the latest 
installation.

Software License Agreement

For the complete software license agreement with details on the license 
conditions, please refer to the COMSOL Software License Agreement. The PDF 
can be downloaded from this link: www.comsol.com/sla. The license agreement 
is also available in your installation folder.
• On Windows, it is located at:

C:\Program Files\COMSOL\COMSOL53\Multiphysics\doc 
\pdf\COMSOL_Multiphysics\COMSOL_SoftwareLicenseAgreement.pdf

and can also be accessed from the Windows Start menu, under 
COMSOL Multiphysics 5.3>COMSOL Documentation.
• On macOS, it is located at:

/Applications/COMSOL53/Multiphysics/doc/pdf/COMSOL_Multiphysics/
COMSOL_SoftwareLicenseAgreement.pdf

• On Linux, it is located in the installation directory, for example:

/usr/local/comsol53/multiphysics/doc/pdf/COMSOL_Multiphysics/
COMSOL_SoftwareLicenseAgreement.pdf

License Types

There is a variety of license options, and the steps involved when installing can 
differ depending on which license type you have acquired. No license type restricts 
usage to just one operating system but you are able to choose to install on either 
Windows, macOS, or Linux. A COMSOL Multiphysics model file saved on one 
platform can be opened on another. Certain license types come with restrictions; 

In this guide, the term COMSOL 5.3 refers not only to 
COMSOL Multiphysics 5.3 but also to any of the add-on 
products, as well as COMSOL Server 5.3 and its add-ons.
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make sure you know which license type you have before proceeding with the 
installation.

COMSOL MULTIPHYSICS

The following is an overview of the license types for COMSOL Multiphysics:

Named Single User License (NSL)
The COMSOL Multiphysics software may be installed and operated on up to four 
(4) individual computers, provided it is only accessible to, and operated by, a 
single licensed user designated by us as the Named User for that license and 
provided that the Named User may concurrently use the software on only two (2) 
of those computers at any given time. The NSL version of the software may not 
be accessed or used over a network or remotely.

CPU-Locked Single User License (CPU)
You can install the COMSOL Multiphysics software on one designated computer 
and different users can take turns using the software on that computer, one session 
at a time. The CPU version of the software may not be accessed or used over a 
network or remotely.

Floating Network License (FNL)
Licensed per concurrent user, you can install the software on as many machines on 
your network as you want for use within your country or territory. COMSOL 
Multiphysics software can run on local computers with the network being used 
only for license authentication, or alternatively you can run the software on a 
remote computer over your network. Cluster and cloud computing is supported 
on Windows® and Linux® platforms.

All COMSOL licenses allow for multicore/multiprocessor 
shared-memory computing. How many cores or processors you 
can utilize is only limited by your hardware configuration and 
operating system. In the COMSOL Desktop you control the 
number of processors from the File menu (Windows) or Options 
menu (macOS and Linux), under Preferences>Multicore and 
Cluster Computing.

For a full description and definition of the different license types, 
see the COMSOL Software License Agreement. All of the license 
types may not be available in your region.
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Class Kit License (CKL)
As many as 30 students and teachers can simultaneously use the software for a class 
over a school network. Students may use the software for homework use, and 
teachers may use the software for lesson preparation.

COMSOL SERVER

The following is an overview of the license types for COMSOL Server:

COMSOL Server License (CSL)
Licensed on a concurrent user basis. Each concurrent user may run up to four 
concurrent sessions. The CSL version of the software enables you to run 
applications built with the Application Builder. The CSL allows you to host and 
run those applications within your organization and also to those outside your 
organization who time share your concurrent user slots, worldwide. Applications 
can be accessed through a major web browser on a variety of operating systems or 
a COMSOL client for the Windows® operating system. See System Requirements 
for detailed requirements.

Academic Server License (ASL)
Licensed on a 300 concurrent user basis. Each concurrent user may run up to four 
concurrent sessions. The ASL version of the software enables you to run 
applications built with the Application Builder. The ASL allows you to host and 
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run those applications for students, faculty, and staff of your academic institution 
or of any other academic institution, worldwide.

License Management Tools

The FlexNet License Manager Software
Depending on your region and operating system, any of the above license types 
may require that the FlexNet license manager software is installed and started 
before running a COMSOL product. The FlexNet license manager comes 
bundled with any COMSOL installation. You can view the contents of the license 
file (license.dat) that you received from your COMSOL representative by 
opening it with a text editor or word processing software. If the file contains a line 
starting with the word SERVER, then the FlexNet license manager is required. 
For a Floating Network License, the purpose of the FlexNet license manager 
software is to count the number of concurrent users and to give an error message 
if the number of users exceeds the licensed number of concurrent users. 
Depending on your region and operating system, the FlexNet license manager 
software might also be needed for a Single User License. In that case, the purpose 
of the license manager software is to lock the COMSOL session to a COMSOL 
authorized computer. See License Manager Installation on Windows for more 
information. The COMSOL software products and the license manager can be 
installed in any order, except if you are installing based on a port number and host 
name. In that case, the license manager software needs to be installed and started 
before installing COMSOL.

Dongle Hardware Lock
Depending on your region and operating system, any of the above license types 
might require a dongle (hardware lock). If you have received a dongle to use with 
COMSOL, please refer to instructions given to you by your COMSOL 
representative.
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COMSOL Access

COMSOL Access is a service provided by COMSOL that gives you access to 
additional content on www.comsol.com and allows you to:
• Download products
• Update products (restricted to customers with an active subscription)
• Edit contact and license information
• Access the Knowledge Base (unabridged access to all parts is restricted to 

customers with an active subscription)
• Contact technical support
• Manage event registrations
• Manage abstract submissions to the COMSOL Conference
• Access to the COMSOL Exchange on-line model sharing
• Participate in the Community Discussion Forum

Registering with COMSOL Access is required for product download and 
installation.
 | 15
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Installing on Windows

Instal lation over the Internet

INSTALLATION OF A TRIAL LICENSE OVER THE INTERNET

A trial license can be given to you with the intention to test the software without 
any payment obligation for noncommercial and nonproduction use. This option 
is not available in all regions.
Installation of a Single User Trial License on Windows requires a license passcode. 
A passcode has a form similar to:

9FFF3FFFF7F5-TYUS-140917-17074436-384661755

This is usually sent to you by a COMSOL representative by email. Once you locate 
your passcode, follow these steps to prepare for download and installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
http://www.comsol.com/product-download.

2 If you have not already created a COMSOL Access account, you are prompted 
to create it. When you have created the account, you can enter your trial 
passcode to associate it with your account information.
If you already created a COMSOL Access account, you can associate the license 
file with your account on the COMSOL Access page under Manage Licenses at 
www.comsol.com/access/licenses.

3 Follow the web-based instructions to download the software.
4 Continue with the instructions in the section Downloading and Installing the 

COMSOL Software.

INSTALLATION OF A PAID-FOR LICENSE OVER THE INTERNET

Installation of any paid-for license on Windows requires a license file that is sent 
to you by your COMSOL representative by email. To be able to generate the 
license file, information about your hardware is needed in the form of a hostid 
(host ID). The hostid is used to lock the license to your hardware and needs to be 
sent by you to a COMSOL representative prior to the license file being generated.
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Obtaining the Hostid
Follow these steps to obtain a hostid:
1 First open the command window by pressing the keyboard Window button+R. 

If you don’t have a Window button, click the Start button, enter cmd, and press 
OK or Return.

2 Enter ipconfig /all at the command prompt and press Return. The displayed 
information looks similar to this:

3 The hostid you are looking for is here called Physical Address, also known as 
Ethernet address or MAC address.

To place the number on the Windows clipboard, right-click the text in the 
command window and select Mark in the menu, mark with the mouse, and press 
Return. Alternatively, you can type the command:
getmac /FO LIST /V | clip

which also places the information on the Windows clipboard.
4 Now press Ctrl+V to paste the hostid to the text body of an email to be sent to 

a COMSOL representative.

Obtaining the Host Name
If you have been informed by your COMSOL representative that you need to run 
the FlexNet license manager for your installation, then you also need the Host 
Name. The Host Name is encircled in the screen shot above. If your network 
administrator prefers to use a fixed IP address for this particular computer, this IP 
Address can be optionally used in place of the Host Name. For more information 
on license manager installation see License Manager Installation on Windows.

Hostid for PCs with Wireless Adapters
If you plan to install on a computer with a wireless network adapter, you need the 
physical address of both the wireless and the Ethernet adapter. If the COMSOL 
representative asks you for the hard disk serial number instead of the hostid, type 
vol at the Windows command line prompt. The output looks like

Volume Serial Number is 2C9F-5930
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Obtaining the License File from a COMSOL Representative
Send the hostid information, as well as Host Name, if applicable, in an email to 
your COMSOL representative, who responds with an email including an attached 
license file (license.dat). Save this file to any location on your computer. You 
need to refer to it during installation. The license file is a text file and below is an 
example of the contents of a license.dat file for a Single User License on 
Windows. This example license file shows that the licensed products are 
COMSOL Multiphysics, Particle Tracing Module, Subsurface Flow Module, and 
LiveLink™ for Excel®.

#------------------------------------------------------------------
# COMSOL 5.3 NSL License No: 1234567 Windows/Mac
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
FEATURE SERIAL LMCOMSOL 5.3 permanent uncounted \

VENDOR_STRING=C,18000100200 HOSTID=ANY sort=100 SN=1234567 \
TS_OK SIGN=8045890A6FE4

FEATURE COMSOL LMCOMSOL 5.3 permanent uncounted HOSTID="70f2b12f4dfd \
0116b8cc761a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=E607EB680852

FEATURE PARTICLETRACING LMCOMSOL 5.3 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3835733C6290

FEATURE SUBSURFACEFLOW LMCOMSOL 5.3 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3A9BA162C9E4

FEATURE LLEXCEL LMCOMSOL 5.3 permanent uncounted HOSTID="70f1a12f4dfc \
0026b9cc760a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=EE9C11E44356

FEATURE COMSOLGUI LMCOMSOL 5.3 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=0D0A83382550

A Single User License file can normally not be edited or changed in any way by 
the user but has to be identical to the one sent to you by a COMSOL 
representative. If you were sent a license file that requires a license manager, then 
minor edits are required. For information on the type of license file required for 
installations using a license manager, see The License File.

Registering with COMSOL Access
Once you have saved your license file, follow these steps to register or login to 
COMSOL Access to start the installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download.
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2 If you haven’t already created a COMSOL Access account, you are prompted 
to create it. When you have created the account, point to your license file 
(license.dat) to associate it with your account information.
If you already created a COMSOL Access account, then you can associate the 
license file with your account on the COMSOL Access page under Manage 
Licenses at www.comsol.com/access/licenses.

3 Continue with the instructions in the next section.

Downloading and Instal l ing the COMSOL Software

1 Go to the web page www.comsol.com/product-download. To download the 
COMSOL installer, you must first create a COMSOL Access account as 
described in the section Installation over the Internet.

2 You are now given the options of downloading the COMSOL online installer 
or the COMSOL offline installer (an ISO image).

STARTING THE ONLINE INSTALLER FOR INSTALLATION OVER THE INTERNET

The COMSOL Installer is a user interface tool that guides you through the 
installation process. Start the COMSOL Installer by running the downloaded file 
COMSOL53_win.exe. The COMSOL 5.3 Installer window should now appear. 
Next, continue with the instructions in the section Running the COMSOL 
Installer.

INSTALLATION FROM DOWNLOADED ISO IMAGE

1 Download the offline installer. The file to download is called 
COMSOL53_dvd.iso.

2 When you have downloaded the ISO image, burn the ISO image to a disc to be 
able to install. In Windows 8 or later you have the option of directly mounting 

If you have problems downloading (such as Error downloading file. 

Connection refused: connect), please review this knowledge base 
entry: www.comsol.com/support/knowledgebase/1149. If you 
still have problems, contact your local COMSOL representative or 
technical support from the Support Center page 
www.comsol.com/support.
 | 19

http://www.comsol.com/access/licenses/
http://www.comsol.com/product-download/
http://www.comsol.com/support/knowledgebase/1149/
http://www.comsol.com/support/


the ISO image by right-clicking on the ISO image and selecting Mount and then 
continuing directly with the installation. In all supported Windows versions you 
can also burn a disc by right-clicking on the ISO image and selecting Open with 
and then Windows Disc Image Burner.

INSTALLING FROM A DVD OR MOUNTED DVD IMAGE

This section also applies if you have received a DVD from a COMSOL 
representative. The COMSOL Installer is a user interface tool that guides you 
through the installation process. Once you have inserted the COMSOL DVD into 
the DVD drive (or mounted the image), the COMSOL Installer window should 
appear automatically; if not, run the file setup.exe on the installation DVD. The 
COMSOL 5.3 Installer window should now appear. Now continue with the 
instructions in the section Running the COMSOL Installer.

Instal lation from a USB Flash Drive

This section applies if you have received a USB Flash Drive from a COMSOL 
representative.

STARTING THE INSTALLER FROM A USB FLASH DRIVE

The COMSOL Installer is a user interface tool that guides you through the 
installation process. Insert the USB Flash Drive into a USB port on your 
computer. The COMSOL Installer window should appear automatically; if not, 
run the file setup.exe on the USB Flash Drive. The COMSOL 5.3 Installer 
window should now appear. Now continue with the instructions in the section 
Running the COMSOL Installer below.

Running the COMSOL Instal ler

The steps for running the COMSOL Installer are independent of the installation 
media option you used. If you have followed the above instructions, the 
COMSOL Installer should now appear.
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1 Select your language for the installation and click Next. The language selected 
is also your default language in COMSOL. You may also need to install the fonts 
for the languages that you want to use when running COMSOL.
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2 In the COMSOL Installer, select one of the following options:
- Click New COMSOL 5.3 Installation and proceed to Step 3 (License Page) to 

make a new installation.
- Click Add/Remove Products and Reinstall and proceed to Step 5 (Platform 

Page) to change or reinstall an existing installation. For example, use 
Add/Remove Products and Reinstall when adding or removing 
documentation files for products installed or when adding or removing a 
product that your license includes.

- Click Change License and proceed to Step 3 (License Page) to update the 
license of an existing installation. Use this option when COMSOL is installed 
and you get a new license file. The installer then removes products not 
licensed any more and lets you go through the Add/Remove Products 
procedure to add or remove products for the new license. If your trial license 
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has expired you can use the Change License option to re-enable a paid-for 
license.

- Click Uninstall COMSOL 5.3 to remove an existing installation. For instructions 
on this option, proceed to Removing (Uninstalling) the COMSOL 
Installation.

LICENSE PAGE

3 After selecting one of the four options, the following is displayed:

After reading the license agreement, click the I accept the terms of the license 
agreement button and specify the license. Use one of the following license 
formats, depending on which license you have:
- Passcode: Use this option for a Single-User Trial License. Enter your 

passcode, which is a series of characters and numbers that has a form similar 

You can change the path to the existing installation by pressing the 
F1 key.
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to FFFFFFFFFFFF-TYUS-123456-1234567-123456789. Note that the 
passcode is case sensitive.

- License file: Use this option for any type of regular paid-for license installation. 
Enter the path to an existing license file or click Browse to select the file 
license.dat. This license file is sent to you by a COMSOL representative, 
typically by email.

- Port number and Host Name: Use this option if your license administrator has 
given you a port number and Host Name for a license manager for COMSOL 
that is running somewhere on your organization’s network. Enter the Host 
Name of the computer or server running the license manager and its license 
manager port number.

- Three-server redundancy: Use this option if your license administrator has 
given you three port numbers and Host Names for the three-server 
redundancy license manager option. Enter the Host Names and license server 
port numbers of the three-server redundant configuration.

Change License
If Change License was selected in Step 2, a menu in the upper-left area of the 
Installer lets you choose to use an existing paid license or a trial license, or you can 
choose to specify a new license.
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Click Next and proceed to Step 5 if you want to change to a license with different 
products. Otherwise, proceed to Step 10.
4 Click Next.

LICENSE NUMBER PAGE

This page only appears if you have a license file corresponding to several different 
licenses (a so-called merged license file). From the list of license numbers, select 
the one you want to install. Both COMSOL Multiphysics licenses and COMSOL 
Server licenses can appear here. The license number choice you make here will 
affect the available products on the next page.

PRODUCTS PAGE

5 Select the COMSOL products to install, which applications and documentation 
to install, and specify the path to the COMSOL installation folder.
In the list of products under Select products to install, all products that your 
license includes are selected. In addition, the License Manager check box is 
selected. Depending on your region and operating system, the license type may 
require that the FlexNet license manager software is installed and started before 
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running COMSOL (see License Management Tools). In some cases, however, 
the FlexNet license manager software is installed automatically during the 
COMSOL installation.
From the options under Application libraries, choose one of the following 
installation options for application libraries:
- Install application libraries for selected products (the default) to install the 

application libraries for the licensed products that you have selected.
- Install application libraries for all products to install the application libraries for 

all COMSOL products. You have then the possibility to browse and open 
applications from all products’ application libraries.

- Do not include application libraries to not install any application libraries. You 
can choose to download selected applications after the installation using the 
Application Library Update.

From the options under Documentation, choose one of the following installation 
options for the product documentation:
- Install documentation relevant to selected products (the default) to install the 

documentation for the licensed products that you have selected. For some 
products, documentation for other relevant products is also installed, so that 
you get access to documentation for functionality included in the licensed 
products but covered in other products’ documentation.

- Install documentation for all products to install the documentation for all 
COMSOL products. You have then the possibility to view and search all 
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COMSOL documentation, including documentation for products not 
included in your license.

- Online documentation only to not install any documentation. You can still view 
documentation and access context help using online documentation provided 
by COMSOL, but no documentation files are installed on your computer.

Under Destination folder, a default installation destination is suggested; for 
Windows, typically C:\Program Files\COMSOL\COMSOL53\Multiphysics. 
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Click Browse or type another destination directory if needed.

Add/Remove Products and Reinstall
- If Add/Remove Products and Reinstall or Change License was selected in Step 2, 

the Products page includes a Reinstall selected and installed products check 
box. If you select this check box, the selected set of products determines 
which software components, documentation, and models are to be added or 
removed. Products that are selected are added if not previously installed, and 

If Change License was selected earlier and you are changing the 
license of an already existing installation, you need to pay attention 
to which check boxes are selected. If you are adding products not 
previously part of your installation, but added with the new license 
file, then you need to verify the selection of the check boxes for 
the corresponding installation components. (If you do not, the 
license information is still correct but the software components 
needed to run the products will be missing.)
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products that are not selected are removed if previously installed. The selected 
set only affects those products that you have licensed..

6 Click Next.

OPTIONS PAGE

7 On this page, you can set the following installation options:
- Create COMSOL Multiphysics 5.3 shortcuts on Windows Desktop.
- Create COMSOL Multiphysics 5.3 folder in the Windows Start Menu.
- Add Windows Firewall rules for COMSOL server programs. This check box adds 

firewall rules that allows COMSOL server programs to open ports and 

You can also add, remove, and repair COMSOL products from 
the installed instance. When adding or repairing products, you can 
select to download the files from the Internet or to provide the 
original DVD.
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communicate over the computer network. If you clear this check box, you 
may get a warning from the Microsoft Firewall when you start a COMSOL 
server, or a COMSOL server may not work as expected when you run it as a 
Windows service.

- Associate the .mph file type with this COMSOL installation.
If this check box is selected, you can open COMSOL models by 
double-clicking them.

- Install Microsoft DirectX® runtime binaries.
Clear the Install Microsoft DirectX® runtime binaries check box if you 
previously experienced problems using DirectX on your computer. DirectX 
can be used by COMSOL Multiphysics for accelerated graphics rendering. If 
you clear this check box, then you still have two graphics options: OpenGL 
or software rendering. Once installation is complete, you can change the 
graphics rendering method from the Preferences dialog box on the Options 
menu in the COMSOL Desktop.

- Set permanent security policy for applications. If you select this option, the 
next page in the installer provides security options that you can set 
permanently; see Security Page. If you set a permanent security policy, the 

For a Floating Network License, you can access COMSOL with a 
Windows Remote Desktop connection. This way of accessing 
COMSOL is only supported with the software rendering graphics 
option.
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security settings in the Preferences dialog box is not available when you run 
COMSOL Multiphysics.

- For non-Latin (Asian) installation languages only: Select the font family to 
use. Here you can choose a font family that supports Asian characters.

The following two options are available under Update:
- Check for updates after installation. This option is selected by default. The 

installer then checks and applies all updates that are available for the version 
that you install.

- Enable automatic updates after installation. Select this check box if you want 
COMSOL to automatically check for and apply available software updates.

- If you install over the Internet using a proxy server, you can specify the host 
name, port number, and, optionally, a username and password if required. If 
you do not enter a port number, COMSOL uses port 443, which is the 
default port setting for the HTTPS protocol. These settings do not appear if 
you do not perform an installation via the Internet.

8 Click Next.
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LIVELINK PAGE

9 The LiveLink page contains installation settings for the LiveLink™ products:
- Install LiveLink™ for Excel® for all users. If you select this check box, the 

installation of LiveLink™ for Excel® is global to the machine and is available 
no matter which user is logged on. Otherwise, the installation is only available 
to the current user.

- For the LiveLink™ products for MATLAB®, PTC® Pro/ENGINEER®, and 
PTC® Creo® Parametric™, specify the path to their respective installation or 
common file folders.
32 | 



LICENSE MANAGER PAGE

10 The License Manager page appears if the COMSOL Installer installed the 
FlexNet license manager and your computer has been designated to run the 
license server. If this page does not appear you can manage the license server 
using LMTOOLS; see Starting the License Manager. This page contains the 
following options:
- The Install license manager as a Windows service check box is selected by 

default; if you clear the check box, the license manager will not be available 
as a Windows service.

- The Path to the debug log file field contains a file path to the location of the 
license manager debug log file (default: 
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C:\Program Files\COMSOL\COMSOL53\Multiphysics\license\comsol.log). 
Click Browse to browse to and choose another file path.

- The Service name field shows the service name, LMCOMSOL, for information 
only.

- Under Additional license manager options, you can select any of the following 
check boxes:
Select the Allow the lmdown command to be executed only from this computer 
check box to restrict the access to the lmdown command, which you can use 
to shut down the license manger, to this computer only.
Select the Disable the lmdown command check box to make the lmdown 
command unavailable.
Select the Disable the lmremove command check box to make the lmremove 
command, which you can use to remove a user’s license, unavailable.
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SECURITY PAGE

11 The Security page is only available if you have selected the Set permanent security 
policy for applications check box.

COMSOL includes security settings for controlling access to, for example, 
system properties, file systems, and runtime security settings from methods and 
external libraries, primarily for use in applications created using the Application 
Builder. The following security settings are available on the Security page in the 
installer:
- Select the Allow batch jobs check box to allow batch jobs. This restriction affects 

the Batch, Batch Sweep, Cluster Computing, and Cluster Sweep nodes in the 
COMSOL Desktop model tree.

- Select Allow external processes and libraries to allow applications to start external 
processes on the computer. This includes using the built-in executeOS() 
method. You need to select this check box to call functions written in 
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MATLAB (requires LiveLink™ for MATLAB®). This setting also allows 
external C libraries to be called from methods in an application.

- Select Allow running methods to allow running applications that include 
methods. If you clear this check box, it is not possible to run methods in 
applications.

- Select Allow running applications to allow running applications in general. If you 
clear this check box, it is not possible to run any applications.

By default, all check boxes above except the Allow external processes and libraries 
check box are selected.
- The Enforce security restrictions check box is selected by default. If selected, this 

check box enforces the following restrictions on methods and Java libraries 
under Methods and Java libraries:

- Select the Allow access to system properties check box to read and write values to 
system properties such as System.getProperty("cs.np") which can be used 
to determine the number of cores that COMSOL Multiphysics currently 
uses.

- Select the Allow changes to the runtime system check box to allow methods and 
Java libraries to change the runtime system — for instance, by modifying class 
loaders.

- From the File system access list, select Temporary and application files (the default) 
to restrict methods and Java libraries to only have access to such files, or select 
All files to allow methods and Java libraries to access all files that you have 
permissions to access on the file system.

- Select the Allow access to network sockets check box to allow methods and Java 
libraries to open sockets for network access.

- Select the Allow control of the network authentication method check box to allow 
methods and Java libraries to control the network authentication method 
used.

- Select the Allow access to classes through reflection check box to allow access to all 
members in a class through reflection.

- Select the Allow access to runtime security settings check box to allow methods 
and Java libraries to access security settings.

All check boxes above are cleared by default, enforcing those security 
restrictions.

12 Click Next.
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INSTALL PAGE

13 When you click Install the utility now installs or updates COMSOL. The 
installation process might take several minutes. A full installation including all 
products typically takes more than 15 minutes to complete. If you are installing 
over the Internet, the installation time depends on your Internet connection 
speed. The Finish page in Step 13 appears automatically when the installation 
process is finished.
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FINISH PAGE

14 This window appears when the installation is finished. 

If warning or errors were detected, click View Log to open a window that shows 
the installation log. Do not hesitate to contact technical support if you 
encountered any errors and remember to send the installation log file along 
with your technical support inquiry.

15 Click Close to quit the installer.

For information on how to run COMSOL Multiphysics after installation, see 
Running COMSOL Multiphysics on Windows. If you are installing on macOS, 
see Running COMSOL Multiphysics on macOS. If you are installing on Linux, 
see Running COMSOL Multiphysics on Linux.
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Removing (Uninstal l ing) the COMSOL Instal lation

To remove a COMSOL installation from your system, you can uninstall using the 
COMSOL Installer’s uninstallation option. The uninstaller deletes all COMSOL 
files and directories on the system that were installed by the COMSOL installer. 
Additional files and folders created after installation are not removed. 
If COMSOL Multiphysics is run with MATLAB, close MATLAB before starting 
the uninstaller. If MATLAB is active, the utility cannot remove certain files.
You can start the COMSOL Uninstaller in a few different ways:
• From the Windows Start Menu, open the Control Panel and select Uninstall a 

program. Find COMSOL Multiphysics 5.3 in the list and select Uninstall.
• From the Windows Start Menu under COMSOL Multiphysics 5.3, select 

COMSOL Launchers>Uninstall.
• Insert the COMSOL DVD and start the COMSOL Uninstaller. Click 

Uninstall COMSOL 5.3  to start removing the installation. Click Close to quit 
the installer when the uninstallation is complete.
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Instal l ing Software Updates

COMSOL provides software updates that improve the software and correct issues. 
To check if an update is available, choose Check For Product Updates from the Help 
menu. If an update is available, an Update dialog box appears. Click Download to 
download the update directly, or click Details to open the COMSOL website 
where you can read about and download the update. To check for updates 
automatically each time you start COMSOL Multiphysics, select the Check for 
updates at launch check box under Product updates on the Updates page in the 
Preferences dialog box. When the update installation starts (close any running 
instance of COMSOL first) you see the following installation window:

If a COMSOL process is running when you start an update installation, you must 
instead first choose one of the following options:
• Cancel: Stop the update so that you can close any running instances of 

COMSOL and then perform the update again.
• Try Again: Restart the update process, if you have closed any running 

instances of COMSOL.
• Continue Anyway: Proceed with the upgrade, ignoring any running instances 

of COMSOL.
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You can either let the installer download the update if you have internet access, or 
you can manually download the update files from 
https://www.comsol.com/product-update.
You can use a direct download (the default) or download via a proxy server. If you 
download via a proxy server, specify the host name and port number for the proxy 
and, if required, a username and password. Other alternative are to launch an 
update from the COMSOL folder in the Start menu or to launch setup.exe from 
the COMSOL installation directory.
As an alternative, you can update COMSOL without starting the update from 
inside COMSOL Multiphysics. To do this, from the Windows Start Menu under 
COMSOL Multiphysics 5.3, select COMSOL Launchers>Update. This launches the 
update program.

Automated Instal lation

You can install the COMSOL software using an automated installation process 
with minimal user interaction. This method requires installation from a DVD or 
DVD image. An answer file then responds to questions while the installer is 
running. The answer file is a text file with a specific format that contains 
predefined settings that the COMSOL installer uses. Start the installation by 
running

<path to DVD>\setup.exe -s <path to answer file>

where <answer file path> is the path to your answer file. A template answer 
file, setupconfig.ini, with detailed usage information is available on the DVD.

AUTOMATED REMOVAL (UNINSTALLATION) OF COMSOL
You can uninstall COMSOL using an answer file:
1 Edit the answer file and set uninstall to 1.
2 Run <path to COMSOL>\bin\win64\setup.exe -s <path to answer 
file>

where <path to answer file> is the path to your answer file. If you attempt to 
enter the command using Windows Command Prompt (cmd), make sure you 
execute the command outside the <path to COMSOL> directory or any 
subdirectory.
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Product Updates and Library Updates

COMSOL periodically releases product updates with improvements and 
corrections to reported problems. By default, COMSOL checks for updates at 
startup. You can turn this feature on and off from the COMSOL Desktop 
Preferences window. Here you can also configure settings for the Application 
Library Update.
The Application Libraries for the COMSOL products are updated on a regular 
basis by COMSOL. To open the Application Library Update window from the 
File>Help menu (Windows users) or from the Help menu (macOS and Linux 
users), select Update COMSOL Application Library.
This connects you to the COMSOL Application Library Update website where 
you can access the latest updates. This includes files that have been added or 
improved since the latest product release.

Using the Updates section in the Preferences dialog box you can configure proxy 
server settings as well as application and documentation directories for the 
Application Library Update. See the COMSOL Multiphysics Reference Manual 
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for more information, including command-line options for the Application 
Libraries.
In a similar way, you can also update the COMSOL Part Libraries. To open the 
Part Library Update window from the File>Help menu (Windows users) or from 
the Help menu (macOS and Linux users), select Update COMSOL Part Library.

LiveLink™ for  Excel® Instal lations

If you have licensed LiveLink™ for Excel®, several tools are accessible from a 
COMSOL tab in the Excel ribbon for working with a COMSOL Multiphysics 
model from an Excel worksheet. You can, for example, extract model definitions 
and results. You can also change model definitions in the worksheet, then update 
and recompute the model.
Whenever you open a COMSOL Multiphysics model from Excel, a COMSOL 
Multiphysics Server is started where the model is loaded. The data transfer 
between Excel and the COMSOL Multiphysics Server application is performed 
using a TCP/IP communication protocol, which accepts only local connections.

LiveLink™ for  SOLIDWORKS®:  Add-In for SOLIDWORKS

If you have licensed LiveLink™ for SOLIDWORKS®, the COMSOL Installer 
registers an add-in called the LiveLink for COMSOL (5.3). This add-in should 
appear in the SOLIDWORKS user interface, listed in the Add-Ins dialog box, 
accessible from the Tools menu.
The add-in provides tools for preparing your SOLIDWORKS design for 
simulation with COMSOL Multiphysics. For example, you can create selections 
on the geometry and set up dimensional parameters. Those selections and 
parameters, together with the geometry, are synchronized with the COMSOL 
Multiphysics model.
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The add-in enables two modes of setting up simulations based on the 
SOLIDWORKS design:
• In one mode you can run SOLIDWORKS and the COMSOL Desktop 

side-by-side and synchronize the geometry between the two.
• In another mode you can work with COMSOL Multiphysics simulations 

inside SOLIDWORKS. This latter mode is called the One-Window 
interface. Only one version of the One-Window interface can be active at a 
time. If you have several COMSOL versions installed, make sure that the 
latest version of LiveLink for COMSOL is selected from the 
COMSOL>One-Window Version menu inside SOLIDWORKS. If required, 
restart SOLIDWORKS after changing the One-Window interface version.

If COMSOL Multiphysics cannot connect to SOLIDWORKS, reinstall 
COMSOL Multiphysics, or follow the instructions from the following link: 
http://www.comsol.com/support/knowledgebase/1122.

LiveLink™ for  Inventor®:  Add-in for Autodesk Inventor

If you have licensed LiveLink™ for Inventor®, the installer registers an add-in for 
Autodesk Inventor called the LiveLink for COMSOL (5.3). This add-in should 
appear in the Add-In Manager dialog box that is accessible from the Options tab 
of the Tools panel in the Autodesk Inventor user interface.
The add-in provides tools for preparing your Inventor design for simulation with 
COMSOL Multiphysics. For example, you can set up dimensional parameters 
that, together with the geometry, are synchronized with the COMSOL 
Multiphysics model.
The add-in enables two modes of setting up simulations based on the Inventor 
design:
• In one mode you can run Inventor and the COMSOL Desktop side-by-side 

and synchronize the geometry between the two.
• In another mode you can work with COMSOL Multiphysics simulations 

inside Inventor. This latter mode is called the One-Window interface.

If COMSOL Multiphysics cannot connect to Inventor, reinstall COMSOL 
Multiphysics , or follow the instructions from the following link:
http://www.comsol.com/support/knowledgebase/1163.
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LiveLink™ for  AutoCAD® Instal lations

If you have licensed LiveLink™ for AutoCAD®, the installer registers an add-in 
with AutoCAD. This add-in is loaded on start-up of AutoCAD and provides 
functionality for synchronizing the geometry between AutoCAD and COMSOL 
Multiphysics. When the add-in is loaded a COMSOL Multiphysics tab appears in 
AutoCAD.
If for some reason the COMSOL Multiphysics tab does not appear try to reinstall 
LiveLink for AutoCAD.

LiveLink™ for  PTC® Pro/ENGINEER®:  Changing the 
Instal lation Path

If you have licensed LiveLink™ for PTC® Pro/ENGINEER®, you need to provide 
the installation path for PTC Pro/ENGINEER or PTC Creo Elements/Pro 
during the install process. The installer registers an add-in with PTC 
Pro/ENGINEER called LiveLink for COMSOL (5.3). The add-in should be 
listed in the Auxiliary Applications dialog box that is accessible from the Tools 
menu in the PTC Pro/ENGINEER user interface. The add-in provides 
functionality for selecting dimensional parameters that can be synchronized with 
COMSOL Multiphysics.
After the installation you can configure the interface to work with a different PTC 
Pro/ENGINEER installation. Go to the Preferences window, which you can 
access from the Options menu inside the COMSOL Desktop. There find the 
LiveLink products section and edit the PTC Pro/ENGINEER installation folder. 
It should point to the root directory of the PTC Pro/ENGINEER installation, 
typically

C:\Program Files\proeWildfire 5.0

or, for an installation of PTC Creo Elements/Pro,
C:\Program Files\PTC\Creo Elements\Pro5.0

If you have installed both LiveLink for PTC Pro/ENGINEER and LiveLink for 
PTC Creo Parametric, you can use only one of those during a COMSOL 
Multiphysics modeling session. The default is to connect to PTC Creo Parametric. 
To connect to PTC Pro/ENGINEER select LiveLink for PTC Pro/ENGINEER 
from the Use list.
Restart COMSOL Multiphysics for the changes to take effect.
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Note that changing the PTC Pro/ENGINEER installation folder in the 
Preferences window does not re-register the add-in with that PTC 
Pro/ENGINEER installation. To do this, reinstall COMSOL Multiphysics, or 
follow the instructions from the following links “Parameter Selection is not 
available in the PTC Pro/ENGINEER user interface”:
http://www.comsol.com/support/knowledgebase/1159
If COMSOL cannot connect to PTC Pro/ENGINEER Wildfire 4.0, follow the 
instructions from the following link:
http://www.comsol.com/support/knowledgebase/1162

LiveLink™ for  PTC® Creo® Parametric™:  Add-in for PTC 
Creo Parametric

If you have licensed LiveLink™ for PTC® Creo® Parametric™, you need to provide 
the path to the common files folder in the PTC Creo Parametric installation 
during the installation process.
It should point to the common files directory of the PTC Creo Parametric 
installation, which is typically for PTC Creo Parametric 2.0

C:\Program Files\PTC\Creo 2.0\Common Files\M040

and for PTC Creo Parametric 3.0
C:\Program Files\PTC\Creo 3.0\M190\Common Files

Based on this path the COMSOL Installer registers an add-in that is loaded by 
PTC Creo Parametric. Subsequent changes to the location of the COMSOL or 
PTC Creo Parametric installations will cause the loading of the add-in, and the 
connection between COMSOL and PTC Creo Parametric to fail. Updating PTC 
Creo Parametric will have the same result.
To re-register the add-in with the PTC Creo Parametric installation you can 
reinstall LiveLink for PTC Creo Parametric, or follow the instructions from the 
following link:
http://www.comsol.com/support/knowledgebase/1158. 
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LiveLink™ for  Revit®:  Add-in for Revit

If you have licensed LiveLink™ for Revit®, the installer registers an add-in for Revit 
Architecture. When the add-in is loaded a tab called COMSOL Multiphysics 
appears in Revit Architecture. The COMSOL Multiphysics tab will not appear if 
the add-in cannot be loaded by Revit Architecture. This can happen if, for 
example, the COMSOL installation is moved to a different location. To restore 
the add-in you can reinstall LiveLink for Revit.

LiveLink™ for  Sol id Edge®:  Add-in for Solid Edge

If you have licensed LiveLink™ for Solid Edge®, the installer creates an add-in to 
Solid Edge called LiveLink for COMSOL (5.3). This add-in should appear in the 
Add-In Manager dialog box that is accessible in the Solid Edge user interface if 
you click the Applications button, then select Add-Ins from the menu.
When the add-in is active a COMSOL Multiphysics tab appears in Solid Edge. Use 
the Parameter Selection tool from the tab to select dimensional parameters that, 
together with the geometry, are synchronized between Solid Edge and COMSOL 
Multiphysics.
If COMSOL Multiphysics cannot connect to Solid Edge, reinstall COMSOL 
Multiphysics, or follow the instructions from the following link “Error: Failed to 
connect to Solid Edge”:
http://www.comsol.com/support/knowledgebase/1160

Cluster Instal lation

COMSOL Multiphysics supports two mutual modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support. This section is dedicated to distributed-memory parallel 
installation.
COMSOL Multiphysics can distribute computations on compute clusters using 
the MPI model. One large problem can be distributed across many compute 
nodes. Also, parametric sweeps can be distributed with individual parameter cases 
distributed to each cluster node.
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LICENSE MANAGER

COMSOL Multiphysics requires a Floating Network License for running on 
clusters. Please check the license file for the CLUSTERNODE feature, which 
needs to be present to enable the cluster computing functionality. The license 
manager needs to be accessible from all nodes in the cluster. Therefore it is often 
a good idea to have it run on the head node.

INSTALLATION FOLDER

The COMSOL Multiphysics installation folder should be shared between all 
compute nodes and the head node.

FEATURES

During installation, make sure the Cluster Components feature is selected.

ACCESS TO CLUSTER (WINDOWS SERVER ONLY)
If you work on a desktop PC, install COMSOL on that PC. Before you start, you 
need to install Windows HPC Pack on the PC. This software is free and enables 
you to access the cluster from your PC.
For more information on installing and running COMSOL Multiphysics on 
clusters, see Running COMSOL Multiphysics on Clusters and the COMSOL 
Multiphysics Reference Manual.
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License Manager Installation on Windows

Depending on your region and operating system, you might be required to install 
and run the FlexNet license manager software in order to run COMSOL 
Multiphysics.

What is  the FlexNet® License Manager?

COMSOL uses the FlexNet license manager version 11 from Flexera Software, 
Inc. for license management. (FlexNet was formerly called FLEXlm™.)
The license manager comes bundled with any COMSOL installation. The 
COMSOL software products and the license manager can be installed in any 
order, unless you are installing based on a port number and Host Name. In that 
case, the license manager software needs to be installed and started before 
installing COMSOL.
Installation of any paid-for license on Windows requires a license file 
(license.dat), which is sent to you by a COMSOL representative by email. You 
can view the contents of the license file by opening it with a text editor or word 
processing software. If the file contains a line starting with the word SERVER, 
then the FlexNet license manager is required. For a Floating Network License, the 
purpose of the license manager software is to count the number of concurrent 
users and to give an error message if the number exceeds the licensed number of 
concurrent users. Depending on your region and operating system, the license 
manager software might also be needed for Single User Licenses. In that case, the 
purpose of the license manager software is to lock a COMSOL session to a 
computer that is authorized by COMSOL.
The FlexNet license manager supports a heterogeneous network of Windows, 
Linux, and macOS computers. Both the license manager and the COMSOL 
software can run on either Windows, Linux, or macOS platforms. In this context, 
the computer where the license manager is installed is called the license server and 
any computer that has the COMSOL products installed is called a client. Any type 
of computer can function as a license server, such as a laptop, desktop, workstation 
or a centrally located server. COMSOL can be installed anywhere, typically on a 
local PC or on a file server where users access the program over a network. A single 
computer can function as both license server and client, holding both the license 
manager and COMSOL.
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Even though the license manager and COMSOL can be installed in any order, a 
full test of the installation cannot be done until both are installed.

System Requirements for the FlexNet® License Manager

Before starting the installation process, check that your system meets all necessary 
requirements as listed at: www.comsol.com/system-requirements. For 
COMSOL, all requirements need to be met. If you are running the license 
manager on a license server where you did not intend to run COMSOL, the 
system requirements are less stringent. The license server only needs to meet the 
listed hardware and operating system requirements. For the license manager, 
memory and graphics requirements do not need to be met. The license manager 
is a much less CPU- and memory-demanding application than COMSOL.

FlexNet® License Manager Software Components

The license manager consists of four software components:
• License manager daemon (lmgrd.exe)
• Vendor daemon (LMCOMSOL.exe)
• FlexNet utility program (lmutil.exe)
• FlexNet Control Panel (lmtools.exe)

The two daemons (lmgrd.exe and LMCOMSOL.exe) run on the license server. When 
a user starts COMSOL on a client computer, communication is established 
through the network from the client to the license server and the license manager 
daemon (lmgrd.exe). That daemon in turn makes a request to the vendor daemon 
(LMCOMSOL.exe), which releases licenses according to information in the 
license.dat file. The FlexNet utility program and FlexNet Control Panel are used 
for handling license server management tasks.
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FlexNet® License Manager Documentation

For detailed information on the FlexNet license manager software, choose 
File>Help>Documentation (Windows) or select Help>Documentation (macOS 
and Linux). Then scroll to the bottom of the page to locate a PDF copy of the 
FlexNet License Administration Guide for FlexNet Publisher. You can also find 
the FlexNet documentation on your hard drive. The default folder location is
C:\Program Files\COMSOL\COMSOL53\Multiphysics\doc\pdf\COMSOL_Mu
ltiphysics\FlexNet

The License Fi le

The license file has the same structure on all platforms: Windows, macOS, and 
Linux. In this section, the most important parts of the license file are explained. 
Below is an example of the contents of a license.dat file:

#------------------------------------------------------------------
# COMSOL 5.3 FNL License No: 1234567
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
SERVER apollo.thecompany.com 0050569e1b87 1718
USE_SERVER
VENDOR LMCOMSOL port=1719
FEATURE SERIAL LMCOMSOL 5.3 permanent uncounted \
    VENDOR_STRING=C,5701108 HOSTID=ANY BORROW=720 SN=1234567 TS_OK \
    SIGN=0C3A8BF6722E
INCREMENT COMSOL LMCOMSOL 5.3 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT COMSOLGUI LMCOMSOL 5.3 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT HEATTRANSFER LMCOMSOL 5.3 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLIENTSERVER LMCOMSOL 5.3 permanent 4 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLUSTERNODE LMCOMSOL 5.3 permanent 4 SUPERSEDE DUP_GROUP=U \
    ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT COMSOLBATCH LMCOMSOL 5.3 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT HEATTRANSFERBATCH LMCOMSOL 5.3 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
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THE COMMENT LINES

Comment lines can be included in the license file by starting them with the hash 
symbol #. These lines have no effect on the license server or client.

THE SERVER LINE

In the license.dat file, the contents of the line starting with SERVER should 
contain:
• The Host Name of the license server. In the example above, the Host Name 

is apollo.thecompany.com. This name can be edited by the user.
• The hostid of the license server. In the example above, the hostid is 

0050569e1b87. This number cannot be edited by the user.
• A port number. In the example above, the port number is 1718.This 

number can be edited by the user.

Confirm that the license server Host Name is the actual name of your license server 
(the computer that you intend to run the FlexNet license manager software on); 
otherwise, change it by editing the file. The default port number (1718) can be 
changed in the unlikely event that another program is already using that port 
number (you then get an error message indicating this when starting the license 
manager). If the default port number 1718 is being used, change it to any other 
number between 1025 and 64,000.

THE USE_SERVER LINE

The USE_SERVER line, with no arguments, does not impact the license manager 
but has implications for the client. When a COMSOL client sees the 
USE_SERVER line, it ignores everything in the license file except the preceding 
SERVER lines and transfers checkout validation to the vendor daemon. This 
means that if you are running COMSOL on one computer, and the license 
manager on a different computer, then your license file can only contain two lines: 
the SERVER line and the USE_SERVER line.

THE VENDOR LINE

The VENDOR line defines the name of the LMCOMSOL vendor daemon. This 
name cannot be changed. The vendor daemon is a process that has to be running 
together with the license manager and is automatically started when the license 
manager is started. The LMCOMSOL vendor daemon requires its own port 
number. In the example above, the default port number 1719 is shown.
If the license manager is running on a computer with an active firewall and the 
COMSOL client is outside of that firewall, at least two port numbers must be 
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opened up in the license server’s firewall to allow client computers to connect to 
the license manager and the vendor daemon.
Using the example license file above, configure the firewall to allow access to the 
port numbers 1718 and 1719. If you have chosen other port numbers and 
modified the license.dat file accordingly, configure the firewall to allow access 
to your chosen port numbers. If you are unsure about which port numbers are free 
or how to enable firewall port access, contact your system administrator.
You cannot modify anything in the license.dat file except the license server name 
and (if necessary) port numbers, or the license might not work.

THE SERIAL LINE

The SERIAL line contains information on the license type, license number, and 
the products included in the license.

THE INCREMENT AND FEATURE LINES

The INCREMENT or FEATURE lines contain a product name, version, 
expiration date, and the number of available licenses. The example file above 
shows that the user has a perpetual (permanent) COMSOL 5.3 Floating Network 
License allowing four concurrent users of COMSOL Multiphysics and two 
concurrent users of the Heat Transfer Module. The number after “SIGN=” at the 
end of each INCREMENT line contains a license key. Long lines can be broken 
by a continuation character (\).

The Feature Names
The following table contains the FEATURE names for all products in the 
COMSOL 5.3 product suite:

PRODUCT/FEATURE FEATURE NAME

COMSOL Multiphysics COMSOL

COMSOL Server COMSOLSERVER

COMSOL Multiphysics GUI COMSOLGUI

COMSOL Multiphysics Floating Network License CLIENTSERVER, CLUSTERNODE

AC/DC Module ACDC

Acoustics Module ACOUSTICS

Batteries & Fuel Cells Module BATTERIESANDFUELCELLS

CAD Import Module CADIMPORT, CADREADER

CFD Module CFD

Chemical Reaction Engineering Module CHEM
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Corrosion Module CORROSION

Design Module DESIGN

ECAD Import Module ECADIMPORT

Electrochemistry Module ELECTROCHEMISTRY

Electrodeposition Module ELECTRODEPOSITION

Fatigue Module FATIGUE

File Import for CATIA V5 CATIA5

Geomechanics Module GEOMECHANICS

Heat Transfer Module HEATTRANSFER

LiveLink™ for AutoCAD® LLAUTOCAD

LiveLink™ for PTC® Creo® Parametric™ LLCREOPARAMETRIC

LiveLink™ for Excel® LLEXCEL

LiveLink™ for Inventor® LLINVENTOR

LiveLink™ for MATLAB® LLMATLAB

LiveLink™ for Revit® LLREVIT

LiveLink™ for PTC® Pro/ENGINEER® LLPROENGINEER

LiveLink™ for Solid Edge® LLSOLIDEDGE

LiveLink™ for SOLIDWORKS® LLSOLIDWORKS

MEMS Module MEMS

Microfluidics Module MICROFLUIDICS

Mixer Module MIXER

Molecular Flow Module MOLECULARFLOW

Multibody Dynamics Module MULTIBODYDYNAMICS

Nonlinear Structural Materials Module NONLINEARSTRUCTMATERIALS

Optimization Module OPTIMIZATION

Particle Tracing Module PARTICLETRACING

Pipe Flow Module PIPEFLOW

Plasma Module PLASMA

Ray Optics Module RAYOPTICS

RF Module RF

Rotordynamics Module ROTORDYNAMICS

Semiconductor Module SEMICONDUCTOR

PRODUCT/FEATURE FEATURE NAME
54 | 



In addition, the following postfix additions are available:
• BATCH is a postfix for all COMSOL Multiphysics features to support batch 

processes running on separate computers, normally used only for floating 
network licenses.

• CSL is a postfix corresponding to COMSOL Server license for different 
COMSOL products.

• BACSL is a postfix corresponding to BATCH for COMSOL Multiphysics 
but issued for COMSOL Server licenses.

Instal l ing the License Manager

The FlexNet license manager is automatically installed when installing COMSOL 
Multiphysics unless otherwise specified on the Products page of the COMSOL 
Installer; see Products Page. In some cases, it is also automatically configured to 

Structural Mechanics Module STRUCTURALMECHANICS

Subsurface Flow Module SUBSURFACEFLOW

Wave Optics Module WAVEOPTICS

PRODUCT/FEATURE FEATURE NAME
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run as a service. The check box for the license manager components can be found 
last in the list of software components, as seen in the picture below:

If you do not intend to run the license manager software on the computer for 
which you are installing COMSOL software products, you can clear this check box 
during installation. The license manager components require about 8 MB amount 
of hard disk space.
If you want to install COMSOL on the same computer as the license manager, first 
perform a complete COMSOL installation including the license manager software 
components. When finished, skip the remainder of this section and continue with 
Starting the License Manager.
To install only the license manager, follow the installation instructions for 
COMSOL earlier in this document and on the Products page and clear all check 
boxes except the one for the license manager

AUTOMATED LICENSE MANAGER INSTALLATION

Alternatively, the license manager can be installed using an automated installation 
process with minimal user interaction; see Automated Installation. Set 
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licmanager = 1 in the answer file to install the license manager. Also, it is possible 
to automatically configure the license manager to run as a service on Windows.

Starting the License Manager

The license manager can be started manually, or it can be configured to start 
automatically as a service each time the computer is rebooted.

STARTING THE MANAGER AUTOMATICALLY AS A SERVICE

To set up the license manager as a service from the FlexNet Control Panel 
(LMTOOLS):
1 Locate the COMSOL53\license\win64 folder and run lmtools.exe. Alternatively, 

run LMTOOLS from the Windows Start menu, available under 
COMSOL Multiphysics 5.3>COMSOL Launchers>LMTOOLS.

2 On the Service/License File page choose Configuration using Services.
3 Click the Configure Services tab.

4 Make an entry in the Service Name field, for example, COMSOL License 
Manager.

The installer can set up the license manager to start automatically; 
in case it did, you can skip the following section.
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5 Specify the full paths to lmgrd.exe and license.dat by browsing to their 
locations on your hard drive. The default location for lmgrd.exe is C:\Program 
Files\COMSOL\COMSOL53\Multiphysics\license\win64\lmgrd.exe, and for the 
license file, it is 
C:\Program Files\COMSOL\COMSOL53\Multiphysics\license\license.dat. For 
the debug log file, you can use any name of your choice, for example, 
comsol53.log. For convenience you can place this next to your license file at: 
C:\Program Files\COMSOL\COMSOL53\Multiphysics\license\comsol53.log.

6 Select the Use Services check box (this might not be possible on all platforms, 
but it is recommended when available) and then the Start Server at Power Up 
check box.

7 Click Save Service. The license manager now starts at automatically when you 
reboot the license server computer. If you want to start the license manager 
right away without restarting the license server computer, click Start Server on 
the Start/Stop/Reread page of the FlexNet Control Panel.

STARTING THE LICENSE MANAGER MANUALLY

To start the license manager manually, browse to the license\win64 folder. Now, 
in a Windows command window enter

lmgrd -c ..\license.dat -l ..\comsol53.log

The license manager is now ready to distribute licenses over the network. It writes 
debug information to the log file 
COMSOL53\Multiphysics\license\comsol53.log.

Verifying that the License Manager is  Running

Once you start the license manager, it is good practice to verify that the license 
manager service is running. Start the Windows Task Manager and go to the 
Services page. Check that the LMCOMSOL service is running.

Make sure your Windows user account has read/write permission 
for the folder of the debug log file, otherwise the debug log file is 
not created.
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Starting COMSOL Multiphysics

After the installation is complete and the license manager daemons are running on 
the license server, you can start using the COMSOL products. For more 
information on how to run COMSOL Multiphysics, see Running COMSOL 
Multiphysics on Windows.

Changing the License

If you have received a new license file — for example, when adding COMSOL 
products to an existing license — replace the current license file with the new one. 
Double-check the contents of this file to make sure it lists the products that the 
license includes. See also The Feature Names.

RESTARTING THE LICENSE MANAGER

To restart the license manager, follow these steps:
1 In the Windows Start menu, choose 

COMSOL Multiphysics 5.3>COMSOL Launchers>LMTOOLS.
2 In the FlexNet Control Panel, click, in this order, Stop Server and Start Server.

OBTAINING A HOSTID

If you need to verify the hostid of the license server, you can follow the steps for 
Obtaining the Hostid. Alternatively, if COMSOL is already installed on the license 
server, you can determine the hostid by running the lmhostid command

COMSOL53/Multiphysics/license/win64/lmutil lmhostid

The hostid is typically the Ethernet address (also called a MAC address) of the 
network card of your computer. An Ethernet address has six bytes, each with two 
hexadecimal digits. Thus, the full hostid has twelve hexadecimal digits. 
Alternatively, the hostid can be the volume serial number of your C hard drive. 
The volume serial number has 4 bytes, each with two hexadecimal digits. In this 
case, the full hostid has eight hexadecimal digits.

When the license file has changed, you must restart the license 
manager; otherwise, it continues to use the old license file still in 
memory.
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Troubleshooting License Errors

If you have questions or problems with your installation, see Troubleshooting 
License Errors.
60 | 



Running COMSOL Multiphysics on Windows

After the installation is finished there is a COMSOL Multiphysics 5.3 shortcut 
icon on the Windows desktop:

as well as a COMSOL Multiphysics 5.3 folder on the Windows Start menu. To 
start COMSOL Multiphysics, double-click the desktop icon or select COMSOL 
Multiphysics 5.3 from the Windows Start menu.

CROSS-PLATFORM USER INTERFACE

The default user interface for COMSOL is a Windows application. There is also a 
cross-platform user interface that you can start by going to the bin\win64 folder 
in the COMSOL installation directory and double-clicking comsolxpl.exe. The 
cross-platform user interface is identical to the interface on Linux and macOS.

The COMSOL Multiphysics Folder on The Start Menu

Depending on which COMSOL products and software components you have 
licensed and installed, the COMSOL Multiphysics 5.3 folder on the Windows 
Start menu contains a selection of the items in the following list:
• COMSOL Multiphysics 5.3: Starts the COMSOL Desktop.
• COMSOL Documentation: Starts the COMSOL Documentation window, 

from which you can access and search all the installed documentation. By 
default, the PDF documents open inside the COMSOL Documentation 
application; to instead open them in Adobe Acrobat, you need to modify 
browser settings for the Adobe PDF Reader add-on.
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• COMSOL Launchers: Opens a folder with launchers for the following 
additional COMSOL programs and utilities:
- Setup: Starts the COMSOL Setup program, which you can use to add, 

remove, and repair COMSOL products and to change the license.
- Uninstall: Starts the COMSOL Uninstaller. For more information, see 

Removing (Uninstalling) the COMSOL Installation.
- Update: Starts the COMSOL Installer in update mode.
- COMSOL Multiphysics Client 5.3: Starts a COMSOL Multiphysics Client 

that can be connected to a COMSOL Multiphysics Server.
- COMSOL Multiphysics Server 5.3: Starts a COMSOL Multiphysics Server 

that a COMSOL Multiphysics Client can connect to.
For more information on running COMSOL in client-server mode, see 
Running COMSOL Multiphysics in Client-Server Mode.

- LMTOOLS: Starts the FlexNet license manager control panel (LMTOOLS). 
For more information, see License Manager Installation on Windows.

- For launching COMSOL Multiphysics with any of the available graphics 
rendering options — OpenGL®, DirectX® (Windows only), and software 
rendering — the following shortcuts are available: COMSOL Multiphysics 
5.3 (DirectX), COMSOL Multiphysics 5.3 (OpenGL), and COMSOL 
Multiphysics 5.3 (Software), 

- This folder also contains launchers for COMSOL Multiphysics, COMSOL 
Documentation, and COMSOL with MATLAB (if available), which appear 
on the main COMSOL Multiphysics 5.3 Start menu.

Starting COMSOL Multiphysics for a Classkit License

If you have a Classkit License, you start it by double-clicking its dedicated 
Windows desktop icon:
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Creating Desktop Shortcuts Manually

Sometimes it is necessary to create the COMSOL shortcuts manually, for example, 
when COMSOL Multiphysics is installed on a shared network drive.
1 Locate the COMSOL executable. Its default location is

C:\Program Files\COMSOL\COMSOL53\Multiphysics\bin\win64\comsol.exe

2 Right-click comsol.exe and select Create shortcut, which creates a shortcut 
with a default name comsol.exe - Shortcut. If this shortcut is not created on the 
Desktop, then move it there by drag-and-drop.

CREATING A DESKTOP SHORTCUT MANUALLY FOR THE CROSS-PLATFORM 

USER INTERFACE

The cross-platform user interface for COMSOL that is available on macOS and 
Linux has a slightly different look-and-feel than the user interface for Windows. 
You can get access to the cross-platform user interface from

C:\Program Files\COMSOL\COMSOL53\Multiphysics\bin\win64\comsolxpl.exe

assuming that the default installation location has not changed by you during 
installation.
To create a shortcut to the cross-platform user interface, right-click 
comsolxpl.exe and select Create shortcut, which creates a shortcut with a default 
name comsolxpl.exe - Shortcut. If this shortcut is not created on the Desktop, then 
move it there by drag-and-drop.

CREATING DESKTOP SHORTCUTS MANUALLY FOR A CLASSKIT LICENSE

If you manually create a desktop shortcut for a Classkit License, then, in addition 
to the steps above, the shortcut’s Target needs to be modified with additional 
options. Right-click the COMSOL shortcut icon and select Properties. Change the 
text string in the Target field to

"C:\Program Files\COMSOL\COMSOL53\Multiphysics\bin\win64\comsol.exe" 
-Dcs.ckl
"C:\Program Files\COMSOL\COMSOL53\Multiphysics\bin\win64\
comsolclasskit.ini"

(The complete text string must be written on a single row.)
Here, C:\Program Files\COMSOL\COMSOL53\Multiphysics represents the 
default COMSOL installation directory and this can be changed in the Target field 
text string if your installation is placed in a different folder.
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Running COMSOL Multiphysics in Client-Server Mode

When you start COMSOL Multiphysics by, for example, double-clicking the 
Windows desktop icon, COMSOL Multiphysics is run as a single application that 
includes both the COMSOL Multiphysics Client and COMSOL Multiphysics 
Server, as explained later in this section. However, the COMSOL client-server 
architecture lets you access the COMSOL Multiphysics Server — the COMSOL 
computational engine — as a separate process. For example, the COMSOL 
Desktop can act as a COMSOL Multiphysics Client when connected to a 
COMSOL Multiphysics Server.

You need a Floating Network License to run the COMSOL Multiphysics Server 
and the COMSOL Multiphysics Client on separate computers. However, any 
COMSOL license is sufficient for running the Client and the Server on the same 
computer.
The Client and Server need not run on the same platform. For example, you can 
run the COMSOL Desktop on Windows connecting to a COMSOL Multiphysics 
Server on a Linux or macOS computer. This enables offloading heavy-duty 
computations from your personal laptop or desktop to run just the COMSOL 
Desktop graphical user interface. A typical use would be to run the COMSOL 
Multiphysics Server on a computer with large amounts of memory (RAM) and 
processing power and to use your personal computer for pre- and postprocessing 
with the COMSOL Desktop.

STARTING A COMSOL MULTIPHYSICS SERVER

The COMSOL Multiphysics server is a single user server allowing multiple 
sessions by the same user, one session at a time. To start the COMSOL 
Multiphysics Server, click COMSOL Multiphysics Server in the COMSOL Launchers 
folder underneath your COMSOL Multiphysics folder on the Windows Start 
menu. When you start the COMSOL Multiphysics Server from the Windows Start 
menu, a command window appears asking you for a username and password. You 

The license server is not the same as a COMSOL Multiphysics 
Server. The license manager can run on a computer different from 
both the ones used by COMSOL Desktop and COMSOL 
Multiphysics Server.
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can use any username and password of your choice, it is only used for connecting 
a COMSOL Multiphysics Client with a COMSOL Multiphysics Server.

When the COMSOL Multiphysics Server starts, it listens for a COMSOL 
Multiphysics Client connection on the port listed in the command window. In the 
example above it is port 2036.

CONNECTING A COMSOL CLIENT TO A COMSOL MULTIPHYSICS SERVER

You can start a COMSOL Multiphysics Client session by clicking COMSOL 
Multiphysics Client in the COMSOL Launcher folder underneath your COMSOL 
Multiphysics folder on the Windows Start menu. You can also connect to a 
COMSOL Multiphysics server from the COMSOL Desktop by selecting Connect 
to Server from the File menu. When you start the Client, a Connect to Server 
window appears prompting you for a computer name (Server) where the 
COMSOL Multiphysics Server is running, Port number, Username, and 
Password.

Once you have filled out this information and clicked OK, the COMSOL 
Multiphysics Server command window indicates that a COMSOL Multiphysics 
Client has connected. For more information on running COMSOL in 
Client-Server mode, see the COMSOL Multiphysics Reference Manual.
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Running COMSOL Multiphysics in Batch Mode

You can submit COMSOL Multiphysics batch jobs from the COMSOL Desktop 
and the command line.
To run a COMSOL Multiphysics batch job from the COMSOL Desktop, you 
need to make the Batch feature visible: in the Model Builder tree, click the Show 
button ( ) and select Advanced Study Options. In the Model Builder, 
right-click a Study node and select Batch to create batch jobs.
From the Windows command window, you can start batch jobs using the 
comsolbatch command. This is an example of how such a command could look 
like:

comsolbatch -inputfile in.mph -outputfile out.mph

To run a specific study add the command line option -study <tag>, where <tag> 
is the tag of the study to run, for instance, std1. To see the tag, click the toolbar 
button Model Tree Node Text in the Model Builder and select Tag.
The COMSOL Multiphysics Reference Manual has a dedicated section on 
running COMSOL Multiphysics from the Windows command window, including 
a list of COMSOL commands and associated syntax.

Multicore Settings

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support. This section covers shared-memory processing, or 
multithreading, which is important for the performance of COMSOL 
Multiphysics computations. Some terms that are frequently used when describing 
multithreading are:
• Core: The core is a processor core used in shared-memory parallelism by a 

computational node with multiple processors.
• Speedup is how many times faster a job runs on N cores compared to 1 core, 

on a specific compute node. The speedup depends on the simulation type, 
the hardware used, and hardware drivers used.

In Windows, the default number of processor cores used by COMSOL 
Multiphysics is the total number of available physical cores. For example, if you 
have a 2 x dual core machine, 4 cores are used in parallel by a COMSOL 
Multiphysics process.
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Here is how to find out how many processor cores your Windows machine has:

WINDOWS 8 AND LATER

1 Start the Windows Task Manager (press Ctrl-Shift-Esc or right-click the taskbar 
and choose Start Task Manager).

2 On the Performance page, click CPU. The number of cores can be seen as the 
number next to Cores.

WINDOWS 7
1 In the Windows file browser, right-click Computer or My Computer, select 

Properties.
2 Click Advanced system settings. Go to the Advanced tab.
3 Click the Environment Variables button and look in the System variables list. 

Look for NUMBER_OF_PROCESSORS and check its value. This is actually 
the number of cores. If you have two processors with 2 cores each, this number 
is 4. Alternatively, start a Windows command window and type

WMIC CPU Get DeviceID,NumberOfCores

If you want COMSOL Multiphysics to leave out one or more processor cores you 
can set the number of cores used for a computational job in the Preferences dialog 
box on the Multicore and Cluster Computing page (by first selecting the Number of 
cores check box and then entering the number of processor cores to use).
You can also change the default behavior of COMSOL Multiphysics by setting the 
environment variable COMSOL_NUM_THREADS to the desired number of cores. See the 
COMSOL Multiphysics Reference Manual for more information.

Running COMSOL Multiphysics on Clusters

You can launch COMSOL cluster jobs from the COMSOL Desktop and the 
command line. To run COMSOL Multiphysics on a cluster, you need to make the 
cluster features visible: in the Model Builder tree, click the Show button ( ) and 
select Advanced Study Options. Then in the Model Builder, right-click a Study 
node and select Cluster Computing or Cluster Sweep to create cluster jobs. 
Cluster computing requires a Floating Network License. 
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The following terms occur frequently when describing the hardware for cluster 
computing and shared-memory parallel computing:
• Compute node: The compute nodes are where the distributed computing 

occurs. Each distributed COMSOL process resides in a compute node and 
communicates with other compute nodes using MPI (message-passing 
interface).

• Host: The host is a physical machine (hardware) with a network adapter and 
unique network address. The host is part of the cluster. It is sometimes 
referred to as a physical node.

• Core: The core is a processor core used in shared-memory parallelism by a 
computational node with multiple processors.

The number of used hosts and the number of computational nodes are usually the 
same. For some special problem types, like very small problems with many 
parameters, it might be beneficial to use more than one computational node on 
one host.
A tutorial for cluster testing is included in the Application Libraries window under 
COMSOL Multiphysics>Tutorials>micromixer_cluster.

QUICK TROUBLESHOOTING

• Your first step is to make sure you have the latest release installed. Check that 
you have COMSOL Multiphysics 5.3 or later. Also make sure to install the 
latest product updates.

• For Windows HPC Server, log in to each node with remote desktop and 
start the COMSOL Desktop GUI. No error messages should be displayed.

• If you get the error message “Process status indicates that process is 
running,” then cancel any running jobs in the Windows HPCS Job manager 
or other scheduler that you use. In the COMSOL Desktop, locate the 
External Process page at the bottom right. Click the Clear Status button.

For more information about how to run COMSOL Multiphysics in parallel on 
Windows clusters, see the COMSOL Multiphysics Reference Manual. For 
installation on Clusters, see Cluster Installation.

Running COMSOL Multiphysics on the Cloud

COMSOL Multiphysics supports cloud computing using Windows through 
Amazon Elastic Compute Cloud™ (Amazon EC2)™. See Running COMSOL on 
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the Amazon Cloud. This PDF can be accessed online: 
www.comsol.com/ec2_manual.

Running COMSOL Multiphysics with MATLAB

Running COMSOL Multiphysics with MATLAB requires a LiveLink™ 
for MATLAB® license. To run COMSOL Multiphysics with MATLAB, 
double-click the COMSOL Multiphysics 5.3 with MATLAB icon on the desktop.

Alternatively, start COMSOL Multiphysics with MATLAB from the Start menu 
by pointing to Programs, then to COMSOL Multiphysics 5.3, and then select 
COMSOL Multiphysics 5.3 with MATLAB.
Running COMSOL Multiphysics with MATLAB starts a COMSOL Multiphysics 
Server and a MATLAB Desktop. The COMSOL Desktop is not involved. You can 
change the path to the MATLAB installation in the Preferences window accessed 
from the Options menu of the COMSOL Desktop. For more information, see the 
LiveLink™ for MATLAB® documentation.

STARTING COMSOL MULTIPHYSICS WITH MATLAB USING THE GRAPHICS 

SERVER

To display the plot in a COMSOL graphics window you need to run COMSOL 
Multiphysics with MATLAB using the graphics server. To do so, append the flag 
-graphics to the COMSOL Multiphysics with MATLAB target path.
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Installing on macOS

Instal lation Over the Internet

INSTALLATION OF A TRIAL LICENSE OVER THE INTERNET

A trial license can be given to you with the intention to test the software without 
any payment obligation for noncommercial and nonproduction use. This option 
is not available in all regions.
Installation of a Single User Trial License on macOS requires a license passcode. 
A passcode has a form similar to:

FFFFFFFF-TYUS-123456-1234567-123456789

This is usually sent to you by your COMSOL representative by email. Once you 
locate your passcode, follow these steps to prepare for download and installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
http://www.comsol.com/product-download.

2 If you have not already created a COMSOL Access account, you are prompted 
to create it. When you have created the account, you can enter your trial 
passcode to associate it with your account information.
If you already created a COMSOL Access account, you can associate the license 
file with your account on the COMSOL Access page under Manage Licenses at 
www.comsol.com/access/licenses.

3 Follow the web-based instructions to download the software.
4 Continue with the instructions in the section Downloading and Installing the 

COMSOL Software.

INSTALLATION OF A PAID-FOR LICENSE OVER THE INTERNET

Installation of any paid-for license on macOS requires a license file that is sent to 
you by your COMSOL representative by email. To be able to generate the license 
file, information about your hardware is needed in the form of a hostid (host ID). 
The hostid is used to lock the license to your hardware and needs to be sent by 
you to a COMSOL representative prior to the license file being generated.
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Obtaining the Hostid
Follow these steps to obtain a hostid:
1 Launch the application Network Utility found in the Applications/Utilities folder 

or the /System/Library/CoreServices/Applications folder on macOS Mavericks and 
later.

2 Click the Info tab to the left.
3 Select Network Interface (en0). This corresponds to your Ethernet card, WiFi 

card, or Thunderbolt port.
4 The hostid is the Hardware Address, as shown in the figure below, but with the 

colons (:) removed. If you plan to install on a computer with a wireless network 
card, report the hardware address for both Network Interface (en0) and 
Network Interface (en1).

Obtaining the Host Name
If you have been informed by your COMSOL representative that you need to run 
the FlexNet license manager for your installation, then you also need the Host 
Name. To get the Host Name, launch the Terminal application; then enter 
hostname at the terminal prompt.
If your network administrator prefers to use a fixed IP address for this particular 
computer, this IP Address could be optionally used in place of the Host Name. 
For more information on license manager installation, see License Manager 
Installation on macOS.
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Obtaining the License File from a COMSOL Representative
Send the hostid information, as well as Host Name, if applicable, in an email to 
your COMSOL representative, who responds with an email including an attached 
license file (license.dat). Save this file to any location on your computer. You 
need to refer to it during installation. The license file is a text file. Below is an 
example of the contents of a license.dat file for a Single User License on macOS. 
This example license file shows that the licensed products are 
COMSOL Multiphysics, Particle Tracing Module, Subsurface Flow Module, and 
LiveLink™ for Excel®.

#------------------------------------------------------------------
# COMSOL 5.3 NSL License No: 1234567 Windows/Mac
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
FEATURE SERIAL LMCOMSOL 5.3 permanent uncounted \

VENDOR_STRING=C,18000100200 HOSTID=ANY sort=100 SN=1234567 \
TS_OK SIGN=8045890A6FE4

FEATURE COMSOL LMCOMSOL 5.3 permanent uncounted HOSTID="70f2b13f4dfd \
0116b8cc761a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=E607EB680852

FEATURE PARTICLETRACING LMCOMSOL 5.3 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3835733C6290

FEATURE SUBSURFACEFLOW LMCOMSOL 5.3 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3A9BA162C9E4

FEATURE LLEXCEL LMCOMSOL 5.3 permanent uncounted HOSTID="70f1a12f4dfc \
0026b9cc760a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=EE9C11E44356

FEATURE COMSOLGUI LMCOMSOL 5.3 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=0D0A83382550

A Single User License file can normally not be edited or changed in any way by 
the user but has to be identical to the one sent to you by a COMSOL 
representative. However, if you were sent a license file that requires a license 
manager, then minor edits are required. For information on the type of license file 
required for installations using a license manager, see The License File.

Registering with COMSOL Access
Once you have saved your license file, follow these steps to register or login to 
COMSOL Access and to start the installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download.
72 | 

http://www.comsol.com/product-download/


2 If you haven’t already created a COMSOL Access account, you are prompted 
to create it. While creating the account, point to your license file 
(license.dat) to associate it with your account information.
If you already created a COMSOL Access account, then you can associate the 
license file on the COMSOL Access page with your account under Manage 
Licenses at www.comsol.com/access/licenses/.

3 Continue with the instructions in the next section.

Downloading and Instal l ing the COMSOL Software

1 Go to the web page www.comsol.com/product-download. To download the 
COMSOL installer, you must first create a COMSOL Access account as 
described in the section Installation over the Internet.

2 You are now given the options of downloading the COMSOL online installer, 
the COMSOL offline installer, or a COMSOL DVD (the DVD option is 
available for macOS versions earlier than macOS Sierra only).

STARTING THE ONLINE INSTALLER FOR INSTALLATION OVER THE INTERNET

The COMSOL Installer is a user interface tool that guides you through the 
installation process. The file to download is called COMSOL53_mac.dmg. Start the 
COMSOL Installer by first mounting the downloaded file by double-clicking it. 
Then run the COMSOL Installer using the COMSOL Setup application. The 
COMSOL 5.3 Installer window should now appear. Next, continue with the 
instructions in the section Running The COMSOL Installer below.

INSTALLATION FROM A DOWNLOADED DVD IMAGE

1 Download the DVD image. The file to download is called COMSOL53_dvd.iso.

If you have problems downloading (such as Error downloading file. 

Connection refused: connect), please review this knowledge base 
entry: www.comsol.com/support/knowledgebase/1149. If you 
still have problems, contact your local COMSOL representative or 
technical support from the Support Center page 
www.comsol.com/support.
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2 When you have downloaded the DVD image, you can install directly from the 
downloaded DVD image by double-clicking it to mount it. Alternatively, burn 
the DVD image to a disc to install. If you want to burn the DVD image to a 
disc:
a Launch the Disk Utility application from Applications/Utilities.
b Click the Burn toolbar button. Select the DVD image in the file dialog box 

and open it.
c Insert an empty DVD in the DVD drive and click Burn in the dialog box in 

Disk Utility.

STARTING THE INSTALLER FROM A DVD OR MOUNTED DVD IMAGE

This section also applies if you have received a DVD from a COMSOL 
representative. The COMSOL Installer is a user interface tool that guides you 
through the installation process. To start the installer:
1 Insert the COMSOL DVD into the DVD drive (or mount the image).
2 Launch the COMSOL Installer application from the Finder.
3 The COMSOL 5.3 Installer window appears. Now continue with the 

instructions in the section Running The COMSOL Installer below.

Instal lation from USB Flash Drive

This section applies if you have received a USB Flash Drive from a COMSOL 
representative.

STARTING THE INSTALLER FROM A USB FLASH DRIVE

The COMSOL Installer is a user interface tool that guides you through the 
installation process. To start the installer:
1 Connect the USB Flash Drive to your computer.
2 Launch the COMSOL Installer application from the Finder.
3 The COMSOL 5.3 Installer window appears. Now continue with the 

instructions in the section Running The COMSOL Installer below.
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Running The COMSOL Instal ler

The steps for running the COMSOL Installer are independent of the installation 
media option you used. If you have followed the above instructions, the 
COMSOL Installer should now appear. Now continue with the instructions for 
Windows in the section Running the COMSOL Installer.

Automated Instal lation

You can install the COMSOL software using an automated installation process 
with minimal user interaction. This method requires installation from DVD or 
DVD image. The documentation on how to create an answer file is available in the 
template, setupconfig.ini, which is available on the DVD. When an answer 
file is created, start the installation by running

<path to DVD>/setup -s <answer file path>

where <answer file path> is the path to the answer file.

Removing (Uninstal l ing) the COMSOL Instal lation

To uninstall COMSOL, run the following command in a terminal window:
/Applications/COMSOL53/Multiphysics/setup uninstall

Alternatively, to remove the COMSOL installation, delete the COMSOL53 
folder including all subfolders. The following file may also be added by the 
installer: /Library/LaunchDaemons/com.comsol.lmcomsol.plist.

Product Updates and Application Library Update

COMSOL periodically releases product updates with improvements and 
corrections to reported problems. By default, COMSOL checks for updates at 
startup. You can turn this feature on and off from the COMSOL Desktop 
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Preferences window. Here you can also configure settings for the Application 
Library Update.
The COMSOL Application Library is updated on a regular basis by COMSOL. 
To open the Application Library Update window from the File>Help menu 
(Windows users) or from the Help menu (macOS and Linux users), select Update 
COMSOL Application Library.
This connects you to the COMSOL Application Update website where you can 
access the latest updates. This includes files that have been added or improved 
since the latest product release.
Using the Updates section in the Preferences dialog box, which you open from 
the COMSOL Desktop, you can configure proxy server settings as well as 
application and documentation directories for the Application Library Update. 
See the COMSOL Multiphysics Reference Manual for more information 
including command-line options for the Application Libraries.
As an alternative, you can update COMSOL without starting the update from 
inside COMSOL Multiphysics. To do this, run COMSOL Update.app.

Changing the Path to the MATLAB® Instal lation

You can change the path to the MATLAB installation in the Preferences>LiveLink 
Connections window accessed from the Options menu of the COMSOL Desktop. 
For more information, see the LiveLink™ for MATLAB® documentation. 
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License Manager Installation on macOS

Many of the instructions for installing the FlexNet license manager are similar to 
those for Windows. This section covers only the differences when installing on 
OS X. For general information on the license manager software, see License 
Manager Installation on Windows.

FlexNet License Manager Software Components

The license manager consists of the following software components:
• License manager daemon (lmgrd)
• Vendor daemon (LMCOMSOL)
• FlexNet utility program (lmutil and others)

The two daemons (lmgrd and LMCOMSOL) run on the license server. When a user 
starts COMSOL Multiphysics on a client computer, communication is established 
through the network from the client to the license server and the license manager 
daemon (lmgrd). That daemon in turn makes a request to the vendor daemon 
(LMCOMSOL), which releases licenses according to information in the license.dat 
file. The FlexNet utility programs are used to handle license server management 
tasks.

FlexNet License Manager Documentation

For detailed information on the FlexNet license manager software, from the File 
menu choose Help>Documentation (Windows) or select Help>Documention 
(macOS and Linux) and scroll to the bottom of the page to locate a PDF copy of 
the FlexNet License Administration Guide.
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The License Fi le

The license file for use on macOS is identical to that of Windows. See The License 
File for more information.

Instal l ing the License Manager

The FlexNet license manager is automatically installed when installing the 
COMSOL software unless otherwise specified on the Products page of the 
COMSOL Installer; see Products Page. The check box for the license manager 
components can be found last in the list of software components.
If you want to install COMSOL on the same computer as the license manager, first 
perform a complete COMSOL installation including the license manager software 
components. See License Manager Page for the license manager settings in the 
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installer. For macOS, this page contains additional settings:

In the User to run license manager field, enter the username for a user on the 
computer that will run the license manager. If this field is empty, the root user runs 
the license manager, which is not recommended from a security point of view. 
Optionally, specify a group that the user belongs to in the Group of the user field.
When finished, skip the remainder of this section and continue with Starting the 
License Manager.
To install only the license manager, follow the installation instructions for 
COMSOL earlier in this document, and, on the Products page, clear all check 
boxes except the one for the license manager.

AUTOMATED LICENSE MANAGER INSTALLATION

Alternatively, the license manager can be installed using an automated installation 
process with minimal user interaction; for this option, see Automated Installation. 
Set licmanager = 1 in the answer file to install the license manager.
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Starting the License Manager

Either start the license manager manually or let it run automatically at startup.

STARTING THE LICENSE MANAGER MANUALLY

To start the license manager manually:
1 Launch the Terminal application.
2 Change directory to the license/maci64 directory:

cd /Applications/COMSOL53/Multiphysics/license/maci64

3 Then enter

./lmgrd -c ../license.dat -l /var/tmp/comsol53.log

The server is now ready to distribute licenses over the network. It writes any debug 
information to the log file /var/tmp/comsol53.log.

STARTING THE LICENSE MANAGER AUTOMATICALLY AT STARTUP

By following these steps, the license manager does not need to be started 
manually:
1 Copy the template file com.comsol.lmcomsol.plist to 
/Library/LaunchDaemons. An example:
sudo cp 
/Applications/COMSOL53/Multiphysics/license/maci64/com.comsol.lmcomsol.plist 
/Library/LaunchDaemons/

Typically, the template file must be edited: the lmgrd and license.dat paths 
should be updated, and a user different from root specified for running the 
service.

2 Open the file /Library/LaunchDaemons/com.comsol.lmcomsol.plist in 
a text editor, for example, TextEdit, and make the necessary edits.

3 Set the correct permissions for the file:
sudo chmod 600 /Library/LaunchDaemons/com.comsol.lmcomsol.plist

4 Enable and start the daemon. An example:
sudo launchctl load -w /Library/LaunchDaemons/com.comsol.lmcomsol.plist

The following commands provide an example of an uninstallation of the daemon:
sudo launchctl unload -w /Library/LaunchDaemons/com.comsol.lmcomsol.plist
sudo launchctl remove /Library/LaunchDaemons/com.comsol.lmcomsol.plist
sudo rm -rf /Library/LaunchDaemons/com.comsol.lmcomsol.plist
rm /var/tmp/comsol53.log
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Verifying that the License Manager is  Running

Once you start the license manager, it is good practice to verify that the license 
manager processes are running. Start the Activity Monitor and check for the 
vendor daemon (LMCOMSOL) and the license manager (lmgrd) in the list of 
processes.

Starting COMSOL Multiphysics

After the installation is complete and the license manager daemons are running on 
the license server, you can start using COMSOL Multiphysics. For more 
information on how to run COMSOL Multiphysics, see Running COMSOL 
Multiphysics on macOS.

Changing the License

If you have received a new license file — for example, when adding COMSOL 
products to an existing license — replace the current license file with the new one. 
Double-check the contents of this file to make sure it lists the products that the 
license includes.

RESTARTING THE LICENSE MANAGER

To restart the license manager:
1 Launch the Terminal application.
2 Change the directory to the license/maci64 (64-bit)

cd /Applications/COMSOL53/Multiphysics/license/maci64

3 Enter the commands
./lmdown -c ../license.dat

When the license file has changed, you must restart the license 
manager; otherwise, it continues to use the old license file still in 
memory.
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./lmgrd -c ../license.dat -l /var/tmp/comsol53.log

OBTAINING A HOSTID

If you need to verify the hostid of the license server, you can follow the steps in 
Obtaining the Hostid. Alternatively, if COMSOL is already installed on the license 
server, you can determine the hostid by executing the lmhostid command

COMSOL53/Multiphysics/license/maci64/lmhostid

The hostid is typically the Ethernet address (also called a MAC address) of the 
network card of your computer. An Ethernet address has six bytes, each with two 
hexadecimal digits. Thus, the full hostid has twelve hexadecimal digits.

Troubleshooting License Errors

If you have questions or problems with your installation, see Troubleshooting 
License Errors. 
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Running COMSOL Multiphysics on macOS

The COMSOL Applications

After the installation is finished there are several COMSOL applications available. 
How many are available depends on which products and licenses you have:

COMSOL Multiphysics This is the primary application for running COMSOL 
Multiphysics. It launches COMSOL Multiphysics as a standalone application.

COMSOL Multiphysics (Classkit License) This application launches COMSOL 
Multiphysics for a Classkit License. This application is only available if you have a 
Classkit License.

COMSOL Documentation This application starts the COMSOL Documentation 
window, from which you can access and search all the installed 
documentation. 

COMSOL with MATLAB Use this application for running COMSOL with 
LiveLink™ for MATLAB®. This application is only available if you have a 
LiveLink™ for MATLAB® license.

COMSOL Multiphysics Server This application launches the Terminal application 
and starts a COMSOL Multiphysics Server in a terminal window.

COMSOL Update This application checks for available product updates on 
www.comsol.com

COMSOL Setup This application makes it possible to add, remove, and repair 
COMSOL products and to change the license.

The COMSOL applications do not work if moved outside the 
COMSOL folder. Create an alias if, for example, a desktop icon is 
required.
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Running COMSOL Multiphysics from a Terminal Window

COMSOL Multiphysics can also be launched from a terminal window using the 
shell script COMSOL53/Multiphysics/bin/comsol.
To run the comsol command more easily, include the COMSOL53/bin directory in 
the path or make a symbolic link from /usr/bin/comsol to the comsol script. 
Those with administrator privileges can create a symbolic link with the command

sudo ln -s /Applications/COMSOL53/Multiphysics/bin/comsol /usr/bin/comsol

(assuming COMSOL is installed in the Applications folder). This command asks 
for a password before creating the link.

Running a Classkit License

To start COMSOL Multiphysics using a Classkit License, start COMSOL 
Multiphysics from the terminal window using the -ckl option, for example,

comsol -ckl

Running COMSOL Multiphysics in Client-Server Mode

When you start COMSOL Multiphysics by, for example, launching the COMSOL 
Multiphysics application, COMSOL Multiphysics is run as a single application that 
includes the functionality of both the COMSOL Multiphysics Client and 
COMSOL Multiphysics Server, as explained later in this section. However, the 
COMSOL client-server architecture lets you access the COMSOL Multiphysics 
Server — the COMSOL computational engine — as a separate process. For 

The comsol command must not be moved from the 
COMSOL53/Multiphysics/bin folder. The COMSOL 
applications also use this script.
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example, the COMSOL Desktop can act as a COMSOL Multiphysics Client when 
connected to a COMSOL Multiphysics Server.

You need a Floating Network License to run the COMSOL Multiphysics Server 
and the COMSOL Multiphysics Client on separate computers. However, any 
COMSOL license is sufficient for running the Client and the Server on the same 
computer.
The Client and Server need not run on the same platform. For example, you can 
run the COMSOL Desktop on macOS connecting to a COMSOL Multiphysics 
Server on a Windows or Linux computer. This enables offloading heavy-duty 
computations from your personal laptop or desktop to run just the COMSOL 
Desktop graphical user interface. A typical use would be to run the COMSOL 
Multiphysics Server on a computer with large amounts of memory (RAM) and 
processing power and to use your personal computer for pre- and postprocessing 
with the COMSOL Desktop. 

STARTING A COMSOL MULTIPHYSICS SERVER

To start the COMSOL Multiphysics Server, run the COMSOL Multiphysics 
Server application. A terminal window appears asking you for a username and 
password. You can use any username and password of your choice, it is only used 
for connecting a COMSOL Multiphysics Client with a COMSOL Multiphysics 
Server.
When the COMSOL Multiphysics Server starts, it listens for a COMSOL 
Multiphysics Client connection on the port listed in the command window.

Connecting a COMSOL Multiphysics Client to a COMSOL Multiphysics Server
You can start a COMSOL Multiphysics Client session from the COMSOL 
Desktop by selecting Connect to Server from the File menu in the COMSOL 
Desktop. When you start the Client, a Connect to COMSOL Multiphysics Server 
window appears prompting you for a computer name (Server) where the 

The license server is not the same as a COMSOL Multiphysics 
Server. The license manager can run on a computer different from 
both the ones used by COMSOL Desktop and COMSOL 
Multiphysics Server.
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COMSOL Multiphysics Server is running, Port number, Username, and 
Password.

Once you have filled out this information and clicked OK, the COMSOL 
Multiphysics Server terminal window displays information that a COMSOL 
Multiphysics Client has connected. For more information on running COMSOL 
in Client/Server mode, see the COMSOL Multiphysics Reference Manual.

Running COMSOL Multiphysics in Batch Mode

You can submit COMSOL Multiphysics batch jobs from the COMSOL Desktop 
and the command line.
To run a COMSOL Multiphysics batch job from the COMSOL Desktop, you 
need to make the Batch feature visible: in the Model Builder tree, click the Show 
button ( ) and select Advanced Study Options. In the Model Builder, right-click 
a Study node and select Batch to create batch jobs.
From the terminal window, you can start batch jobs using the comsol batch 
command. This is an example of how such a command could look:

comsol batch -inputfile in.mph -outputfile out.mph

To run a specific study add the command line option -study <tag>, where <tag> 
is the tag of the study to run, for instance, std1. To see the tag, click the toolbar 
button Model Tree Node Text in the Model Builder and select Tag.
The COMSOL Multiphysics Reference Manual includes a dedicated section on 
running COMSOL Multiphysics from the terminal window, including a list of 
COMSOL commands and associated syntax.
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Multicore Settings

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support for Windows and Linux. This section covers 
shared-memory processing, or multithreading, which is important for the 
performance of COMSOL Multiphysics computations. Some terms that are 
frequently used in when describing multithreading are:
• Core: The core is a processor core used in shared-memory parallelism by a 

computational node with multiple processors.
• Speedup is how many times faster a job runs on N cores compared to 1 core, 

on a specific compute node. The speedup depends on the simulation type, 
the hardware used, and hardware drivers used.

On macOS, the default number of processor cores used by COMSOL 
Multiphysics is the total number of available physical cores. For example, if you 
have a 2 x dual core machine, 4 cores are used in parallel by a COMSOL process.

SHARED-MEMORY OPTIONS

From the terminal window, use the comsol command option -np to control the 
number of cores and processors used. The default is to use all available cores and 
processors. For example:

comsol -np 2

launches COMSOL using 2 cores (if available).
You can experiment to find the options that work best for your configuration. For 
more information see the COMSOL Multiphysics Reference Manual.

Running COMSOL Multiphysics on Clusters

You can launch COMSOL Multiphysics cluster jobs from the COMSOL Desktop 
and the command line. To run COMSOL Multiphysics on a cluster, you need to 
make the cluster feature visible: in the Model Builder tree, click the Show button 
( ) and select Advanced Study Options. Then in the Model Builder, right-click a 
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Study node and select Cluster Computing or Cluster Sweep to create cluster jobs. 
Cluster computing requires a Floating Network License.

A tutorial model for cluster testing is included in the Application Libraries window 
under COMSOL Multiphysics>Tutorial models>micromixer_cluster.
For more information about how to run COMSOL Multiphysics in parallel on 
clusters, see the COMSOL Multiphysics Reference Manual. For installation on 
Clusters, see Cluster Installation for Windows and Cluster Installation for Linux.

Running COMSOL Multiphysics on the Cloud

COMSOL Multiphysics supports cloud computing using macOS through 
Amazon Elastic Compute Cloud™ (Amazon EC2)™. See Running COMSOL on 
the Amazon Cloud. This PDF can be accessed online: 
www.comsol.com/ec2_manual.

COMSOL Multiphysics cannot be run on a cluster running 
macOS; however, you can use the Cluster Computing or Cluster 
Sweep feature to connect to a Windows or Linux cluster.
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Installing on Linux

Instal lation Over the Internet

INSTALLATION OF A PAID-FOR OR TRIAL LICENSE OVER THE INTERNET

Installation of any paid-for license on Linux requires a license file, which is sent to 
you by your COMSOL representative by email. To be able to generate the license 
file, information about your hardware is needed in the form of a hostid (host ID). 
The hostid is used to lock the license to your hardware and needs to be sent by 
you to a COMSOL representative prior to the license file being generated.

Obtaining the Hostid
Follow these steps to obtain a hostid:
1 Start a Terminal window.
2 Enter cat /sys/class/net/*/address

This displays all physical Ethernet addresses (also called MAC addresses) which 
consists of six bytes displayed as six pairs of hexadecimal digits such as 
00:40:05:16:E5:25. Choose one that does not consist of zeros only.

Obtaining the Host Name
If you have been informed by a COMSOL representative that you need to run the 
FlexNet license manager for your installation, then you also need the Host Name:
1 To get the Host Name, start a Terminal window.
2 Enter hostname at the terminal prompt.
If your network administrator prefers to use a fixed IP address for this particular 
computer, this IP Address can be optionally used in place of the Host Name. For 
more information on license manager installation see License Manager Installation 

A trial license can be given to you with the intention to test the 
software without any payment obligation for noncommercial or 
nonproduction use. This option is not available in all regions. For 
installation of a Single User Trial License on Linux, you can follow 
the same instructions as for a paid-for license.
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on Linux.

Obtaining the License File from a COMSOL Representative
Send the hostid information, as well as Host Name, if applicable, in an email to 
your COMSOL representative, who responds by email including an attached 
license file (license.dat). Save this file to any location on your computer. You 
need to refer to it during installation. A trial license file for Linux cannot normally 
be edited or changed in any way by the user but has to be identical to the one sent 
to you by a COMSOL representative. However, if you were sent a license file that 
requires a license manager, then minor edits are required. For information on the 
type of license file required for installations using a license manager, see The 
License File.

Registering with COMSOL Access
Once you have saved your license file, follow these steps to register or login to 
COMSOL Access and to start the installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download

2 If you haven’t already created a COMSOL Access account, you are prompted 
to create it. While creating the account, point to your license file 
(license.dat) to associate it with your account information.
If you already created a COMSOL Access account, then you can associate the 
license file on the COMSOL Access page with your account under Manage 
Licenses at www.comsol.com/access/licenses.

3 Continue with the instructions in the next section Downloading the COMSOL 
Installer.

Downloading and Instal l ing the COMSOL Software

1 Go to the web page www.comsol.com/product-download. To download the 
COMSOL installer, you must first create a COMSOL Access account as 
described in the section Installation over the Internet.
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2 You are now given the options of downloading the COMSOL online installer 
or the COMSOL offline installer (a DVD image).

STARTING THE ONLINE INSTALLER FOR INSTALLATION OVER THE INTERNET

The COMSOL Installer is a user interface tool that guides you through the 
installation process. The file to download is called comsol53_lnx.tar.gz. Start 
the COMSOL Installer by first extracting the downloaded file and then running 
the setup script. The COMSOL 5.3 Installer window should now appear. Next, 
continue with the instructions in the section Running The COMSOL Installer. 
below.

INSTALLATION FROM DOWNLOADED DVD IMAGE

1 Download the DVD image. The file to download is called COMSOL53_dvd.iso.
2 When you have downloaded the DVD image, burn the DVD image to a disc. 

Use a DVD burning tools or command such as cdrecord to burn the DVD. 
Alternatively, directly mount the DVD using a loopback device:

mount -o loop COMSOL53_dvd.iso /mnt

STARTING THE INSTALLER FROM A DVD OR MOUNTED DVD IMAGE

The COMSOL Installer is a user interface tool that guides you through the 
installation process. To start the installer:
1 Make sure the COMSOL DVD is in the DVD drive (or mount the image).
2 Type /mnt/setup
The COMSOL 5.3 Installer window appears. Now continue with the instructions 
in the section Running The COMSOL Installer below.

If you have problems downloading (such as Error downloading file. 

Connection refused: connect), please review this knowledge base 
entry: www.comsol.com/support/knowledgebase/1149. If you 
still have problems, contact your local COMSOL representative or 
technical support from the Support Center page 
www.comsol.com/support.
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Instal l ing from a DVD

This section applies if you have received a DVD from a COMSOL representative.
The COMSOL Installer is a user interface tool that guides you through the
installation process. To start the installer:
1 Insert the COMSOL 5.3 DVD into the DVD drive.
2 If the DVD is not mounted automatically by your operating system, use the 
mount command to mount it.

3 To start the installation, enter the command
sh drivepath/setup

where drivepath is the mount point of the DVD drive, for example
/media/cdrom.
You might have to mount the DVD with the option -o exec if your Linux 
mounts the DVD without execute options by default.

The COMSOL 5.3 Installer window appears. Now continue with the
instructions in the section Running The COMSOL Installer below.

Instal lation from USB Flash Drive

This section applies if you have received a USB Flash Drive from a COMSOL 
representative.

STARTING THE INSTALLER FROM A USB FLASH DRIVE

The COMSOL Installer is a user interface tool that guides you through the 
installation process. To start the installer:
1 Connect the USB Flash Drive to your computer.
2 If the USB Flash Drive is not mounted automatically by your operating system, 

use the mount command to mount it.
3 To start the installation, enter the command
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sh drivepath/setup

where drivepath is the mount point of the USB Flash Drive, for example 
/media/usb.
You might have to mount the USB Flash Drive with the option -o exec if your 
Linux mounts the USB Flash Drive without execute options by default.

4 The COMSOL 5.3 Installer window appears. Now continue with the 
instructions in the section Running The COMSOL Installer below.

Running The COMSOL Instal ler

The steps for running the COMSOL Installer are independent of the installation 
media option you used. If you have followed the above instructions, the 
COMSOL Installer should now appear. For a detailed description and screen 
shots of the different COMSOL Installer steps, see the instructions for Windows 
in the section Running the COMSOL Installer. The procedure for running the 
COMSOL Installer on Linux is similar and summarized below with the differences 
from installation on Windows highlighted:
1 When the installer window appears, click New Installation.
2 Read the license agreement, select I accept the terms of the license agreement, 

specify License information, and then click Next.
3 If you have a Named Single User License and you are installing the software on 

the license server, a dialog box opens up and you are asked to enter the user to 
bind the license to.

4 Select the products to install and specify the path to the COMSOL installation 
directory. 

5 Click Next.
6 If you have licensed LiveLink™ for MATLAB®, then specify the MATLAB root 

folder.
7 Click Next.
8 Click Install to start the installation.
9 When the installation process is finished, the Finish window appears. If errors 

arose during installation, this window issues a notification. The installer also 
writes a log entry into the text file comsolsetup.log, which resides in the 
specified installation directory. Click Close to quit the installer. If you installed 
from DVD, use the unmount and eject commands to unmount and eject the 
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DVD. Some Linux configurations automatically unmount and eject the DVD 
when you press the DVD drive button.

10 To make sure all users can easily start COMSOL Multiphysics, include the 
comsol53/bin directory in all users’ paths or make a symbolic link from 
/usr/local/bin/comsol to the comsol command (see the Linux ln command). 
The installer can do this step automatically if you run the installer as an 
administrator..

Web Browser for Viewing the Documentation

The file browser in the bin directory attempts to start common web browsers that 
are available with the supported Linux versions. Edit the file in any text editor to 
adjust it for your preferred web browser. The variable BROWSERS in this file contains 
a list of web browsers in order of preference. If you want to make a specific browser 
the preferred web browser, put it first in the list.

Automated Instal lation

You can install the COMSOL software using an automated installation process 
with minimal user interaction. This method requires installation from DVD or 
DVD image. The documentation on how to create an answer file is available in the 
template, setupconfig.ini, which is available on the DVD. When you have 
created an answer file, start the installation by running

<path to DVD>/setup -s <answer file path>

where <answer file path> is the path to your answer file.

You may also need to install the fonts (using the normal Linux 
distribution methods) for the languages that you want to use 
when running COMSOL Multiphysics.
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Removing (Uninstal l ing) the COMSOL Instal lation

To uninstall COMSOL, run the following command in a terminal window:
/usr/local/comsol53/multiphysics/setup uninstall

Alternatively, to remove the COMSOL installation, delete the comsol53 folder 
including all subfolders and the following files if they exist:
/usr/local/bin/comsol
/usr/local/bin/comsol-5.3
/usr/share/applications/comsol-multiphysics-5.3.desktop
~/.local/share/applications/comsol-multiphysics-5.3.desktop
/usr/lib/systemd/system/lmcomsol.service

Product Updates and Application Library Update

COMSOL periodically releases product updates with improvements and 
corrections to reported problems. By default, COMSOL checks for updates at 
startup. You can turn this feature on and off from the COMSOL Desktop 
Preferences window. Here you can also configure settings for the Application 
Library Update.
The COMSOL Application Library is updated on a regular basis by COMSOL. 
To open the Application Library Update window from the File>Help menu 
(Windows users) or from the Help menu (macOS and Linux users), select Update 
COMSOL Application Library.
This connects you to the COMSOL Application Update website where you can 
access the latest updates. This includes applications that have been added or 
improved since the latest product release.
Using the Updates section in the Preferences dialog box, which you open from 
the COMSOL Desktop, you can configure proxy server settings as well as 
application and documentation directories for the Application Library Update. 
See the COMSOL Multiphysics Reference Manual for more information 
including command-line options for the Application Libraries.
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Changing the Path to the MATLAB® Instal lation

You can change the path to the MATLAB installation in the Preferences>LiveLink 
Connections window accessed from the Options menu of the COMSOL Desktop. 
For more information, see the LiveLink™ for MATLAB® documentation.

Cluster Instal lation

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support. This section is dedicated to distributed-memory parallel 
installation.
COMSOL Multiphysics can distribute computations on compute clusters using 
the MPI model. One large simulation can be distributed across many compute 
nodes. Also, parametric sweeps can be done with individual parameter cases 
distributed to each cluster node.

SYSTEM REQUIREMENTS

The installation instructions above can also be followed for clusters. COMSOL 
supports shared-memory parallelism and distributed-memory parallelism on 
64-bit Linux. For details on system requirements, see 
www.comsol.com/system-requirements.

LICENSE MANAGER

COMSOL Multiphysics requires a Floating Network License for running on 
clusters. Please check the license file for the CLUSTERNODE feature, which 
needs to be present to enable the cluster computing functionality. The license 
manager needs to be accessible from all nodes in the cluster. Therefore it is often 
a good idea to have it run on the head node.

INSTALLATION FOLDER

The COMSOL installation folder should be shared between all compute nodes 
and the head node.

FEATURES

During installation, make sure the Cluster Components feature is selected.
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ACCESS TO CLUSTER

If you work on a computer that is not on the cluster, install COMSOL 
Multiphysics on that computer. Typically, you use a scheduler to launch jobs on 
the cluster. Make sure the scheduler client software is installed on that computer. 
You can configure the installation to use the scheduler by changing the 
comsol.ini file according to the section on MPI Options in the COMSOL 
Multiphysics Reference Manual.
For more information on installing and running COMSOL on clusters, see 
Running COMSOL on Clusters and the COMSOL Multiphysics Reference 
Manual.
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License Manager Installation on Linux

You do not need to install the license manager if you are installing a trial version. 
The paid-for version on Linux, however, always requires a running license 
manager. Many of the instructions for installing the FlexNet license manager are 
similar to those for Windows. This section covers only the differences when 
installing on Linux. For general information on the license manager software, see 
License Manager Installation on Windows. In some cases, however, the 
COMSOL installation also installs and configures the license manager.

FlexNet License Manager Software Components

The license manager consists of the following software components:
• License manager daemon (lmgrd)
• Vendor daemon (LMCOMSOL)
• FlexNet utility program (lmutil and others)

The two daemons (lmgrd and LMCOMSOL) run on the license server. When a user 
starts COMSOL on a client computer, communication is established through the 
network from the client to the license server and the license manager daemon 
(lmgrd). That daemon in turn makes a request to the vendor daemon (LMCOMSOL), 
which releases licenses according to information in the license.dat file. The 
FlexNet utility programs are used to handle license server management tasks.

FlexNet License Manager Documentation

For detailed information on the FlexNet license manager software, click the  
button (File menu) and choose Help>Documentation (Windows) or select 
Help>Documentation (macOS and Linux) and scroll to the bottom of the page 
to locate a PDF copy of the FlexNet License Administration Guide.
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The License Fi le

The license file for use on Linux is identical to that for Windows, except in the case 
of a Named Single User License, which is described below. See The License File 
for general license file information.

LICENSE FILES FOR NAMED SINGLE USER LICENSE

If you have a Named Single User License the installer automatically creates an 
options file that binds the license to the named user. This section describes the 
format of the options file and how the license.dat file points to the options file.
Below is an example of an options file, LMCOMSOL.opt, for a user “philip” who has 
access to COMSOL Multiphysics, the Structural Mechanics Module, and the 
CAD Import Module. Notice that to access COMSOL Multiphysics, the options 
file must include both the COMSOL and the COMSOLGUI features:

INCLUDE COMSOL USER philip
INCLUDE COMSOLGUI USER philip
INCLUDE CADIMPORT USER philip
INCLUDE CADREADER USER philip
INCLUDE STRUCTURALMECHANICS USER philip

Each INCLUDE row in the LMCOMSOL.opt file has a corresponding FEATURE row in the 
license.dat file (with the USER_BASED keyword). The second item on each 
FEATURE row is the name of the feature for which you have a license.
For more information on which FEATURE items are available, see The License 
File.
The license.dat file needs to point to the options file. The path to the options 
file is indicated by the options keyword. If your options file is placed here:

/usr/local/comsol53/multiphysics/license/LMCOMSOL.opt

then the VENDOR row in license.dat should read
VENDOR LMCOMSOL port=1719 
options=/usr/local/comsol53/multiphysics/license/LMCOMSOL.opt

Instal l ing the License Manager

The FlexNet license manager is automatically installed when installing COMSOL 
unless otherwise specified on the Products page of the COMSOL Installer; see 
Products Page. In some cases, it is also automatically configured to run as a service. 
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The check box for the license manager components can be found last in the list of 
software components.
If you want to install COMSOL on the same computer as the license manager and 
you did not choose to install the license manager as a service, first perform a 
complete COMSOL installation including the license manager software 
components. See License Manager Page for the license manager settings in the 
installer. For Linux, this page contains additional settings:

In the User to run license manager field, enter the username for a user on the 
computer that will run the license manager. If this field is empty, the root user runs 
the license manager, which is not recommended from a security point of view. 
Optionally, specify a group that the user belongs to in the Group of the user field.
When finished, skip the remainder of this section and continue with Starting the 
License Manager below.
To install only the license manager, follow the installation instructions for 
COMSOL earlier in this document, and on the Products page, clear all check 
boxes except the one for the license manager.
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AUTOMATED LICENSE MANAGER INSTALLATION

Alternatively, the license manager can be installed using an automated installation 
process with minimal user interaction, see Automated Installation. Set 
licmanager = 1 in the answer file to install the license manager. It is also possible 
to automatically configure the license manager to run on systemd-based Linux 
distributions.

Starting the License Manager

You can start the license manager manually or it can run automatically at boot.

STARTING THE LICENSE MANAGER MANUALLY

To start the license manager manually, make the license/$arch directory the 
current directory and enter

./lmgrd -c ../license.dat -l /var/tmp/comsol53.log

The server is now ready to distribute licenses over the network. It writes any debug 
information to the log file /var/tmp/comsol53.log.

STARTING THE LICENSE MANAGER AUTOMATICALLY AT BOOT

In order for the license manager to start automatically at boot, you need to add 
Bourne shell commands to the appropriate boot script. You must be a superuser 
(root) to edit boot scripts. In some cases, however, the COMSOL Installer 
automatically installs and configures the license manager.

For Linux distributions that use systemd, use the lmcomsol.service file, 
located in the comsol53/license/glnxa64 directory, to start the license 
manager. To use lmcomsol.service, do the following steps:

The installer can set up the license manager to start automatically; 
in case it did, you can skip the following section.

For security reasons, it is recommended that the daemons are not 
started as root. Instead, use a dedicated username to start the 
license manager.
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1 Update the path to lmgrd, license.dat, and comsol.log in case you have 
different locations for these files.

2 Optionally, replace username with an actual username. Preferably do not use 
root; instead, use the account used to install COMSOL or another account 
with access to both the lmgrd executable and the log file location above.

3 Create a /usr/tmp directory if it does not exist and set its permissions to 1777 
with the chmod 1777 /usr/tmp command.

4 Copy the lmcomsol.service file to /usr/lib/systemd/system/ and run 
the systemctl enable lmcomsol and systemctl start lmcomsol 
commands to activate the license manager.

For older Linux distributions, without systemd, the procedure for editing boot 
scripts on each supported Linux distribution appears in the following table:

PLATFORM PROCEDURE

SuSe Linux The following instructions should work for SuSE Linux distributions:

In the comsol53/multiphysics/license/glnxa64 directory, enter the 
commands

cp rc.lm /etc/init.d/comsol53lm
chmod 755 /etc/init.d/comsol53lm

Edit /etc/init.d/comsol53lm, replacing dir with the full path to the 
glnxa64 directory, and replace username with an actual username.

Now create the following link
cd /etc/init.d/rc5.d
ln -s ../comsol53lm S91comsol53lm

Debian 
Linux

The following instructions should work for Debian Linux distributions:

Copy the file comsol53/multiphysics/license/glnxa64/lm_comsol to 
/etc/init.d

Edit /etc/init.d/lm_comsol. Update the FP and MYUSER variables as 
indicated in the file. Use the utility update-rc.d to automatically update the 
system's init script links:

update-rc.d lm_comsol start 99 2 3 4 5 . stop 1 0 1 6 .

This means that the COMSOL license manager is started by runlevels 2, 3, 4, and 
5, and stopped by runlevels 0, 1, and 6. Enter man update-rc.d for more 
information on init scripts. 

Linux, 
General

The following instructions should work for most Linux distributions:

Copy the file comsol53/multiphysics/license/glnxa64/rc.lm and 
paste it at the end of 

/etc/rc.d/rc.local.

Replace dir in the code fragment with the full path to the glnxa64 platform 
directory, and replace username with an actual username.
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Verifying that the License Manager is  Running

Once you start the license manager, it is good practice to verify that the license 
manager processes are running. Use administrative commands such as top or ps to 
check that both the vendor daemon (LMCOMSOL) and the license manager 
(lmgrd) are running. On Linux distributions that include systemd, if the license 
manager is installed as a service according to the instructions, you can run 
service lmcomsol status instead.

Starting COMSOL Multiphysics

After the installation is complete and the license manager daemons are running on 
the license server, you can start using COMSOL Multiphysics. For more 
information on how to run COMSOL Multiphysics, see Running COMSOL 
Multiphysics on Linux.

Changing the License

If you have received a new license file — for example, when adding COMSOL 
products to an existing license — replace the current license file with the new one. 
Double-check the contents of this file to make sure it lists the products that the 
license includes.

RESTARTING THE LICENSE MANAGER

To restart the license manager, make the license/$arch directory under the 
COMSOL installation directory the current directory, then enter the following 
commands:

./lmdown -c ../license.dat

./lmgrd -c ../license.dat -l /var/tmp/comsol53.log

When the license file has been changed, you must restart the 
license manager; otherwise, it continues to use the old license file 
still in memory.
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When installed as a service on Linux distributions with systemd according to the 
instructions, you stop it with the service lmcomsol stop command and start 
it with the service lmcomsol start command.

OBTAINING A HOSTID

If the COMSOL software is already installed on your license server, you can 
determine the hostid by executing the lmhostid command

comsol53/multiphysics/license/glnxa64/lmhostid

Troubleshooting License Errors

If you have questions or problems with your installation, see Troubleshooting 
License Errors.

LINUX STANDARD BASE LIBRARIES

If you get the following error:
./lmgrd: Command not found.

or
./lmgrd: No such file or directory

it might be because some required libraries are missing. The license manager in 
COMSOL 5.3 is built with FlexNet 11.13.1.3, which requires LSB (Linux 
Standard Base) 3.0 or later in order to start. These error messages indicate that the 
license server is missing these required libraries. To solve this problem, install the 
package that provides LSB support for your Linux distribution:
• For Debian and Ubuntu: lsb-core. Installation command:
sudo apt-get install lsb-core

• For Red Hat®: redhat-lsb. Installation command:
sudo yum install redhat-lsb

• For OpenSUSE: lsb. Install using the YaST package manager.

Some modern Linux distribution do not provide lsb-core. The workaround in 
such a case is to create a symlink by running the following command as root or 
with sudo: ln -s /lib64/ld-linux-x86-64.so.2 /lib64/ld-lsb-x86-64.so.3.
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Running COMSOL Multiphysics on Linux

Running COMSOL Multiphysics

If you are running a Linux version with a graphical desktop environment, you 
might find a COMSOL Multiphysics icon that you can simply click to start 
COMSOL Multiphysics in the menus. Alternatively, using a terminal window, you 
can run the comsol command. If it is not available, ask your system manager to 
make it available to you, or, if you have administrative privileges on your Linux 
system, add the comsol command to the search path. The setup can do this 
automatically for you during installation if you run it with root privileges. The 
comsol command is located in the bin folder in the COMSOL installation 
directory. This is a typical example of a command that adds comsol to the search 
path is (assuming you are logged in as root):

ln -s /usr/local/comsol53/multiphysics/bin/comsol /usr/bin/comsol

Multicore Settings

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support for Windows and Linux. This section covers 
shared-memory processing, or multithreading, which is important for the 
performance of COMSOL Multiphysics computations. Some terms that are 
frequently used in when describing multithreading are:
• Core: The core is a processor core used in shared-memory parallelism by a 

computational node with multiple processors.

In order for the help system to work on Linux, some packages 
need to be installed; for details, see 
www.comsol.com/system-requirements.
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• Speedup is how many times faster a job runs on N cores compared to 1 core, 
on a specific compute node. The speedup depends on the simulation type, 
the hardware used, and the hardware drivers used.

On Linux, the default number of processor cores used by COMSOL Multiphysics 
is the total number of available physical cores. For example, if you have a 2 x dual 
core machine, 4 cores are used in parallel by a COMSOL process.

SHARED-MEMORY OPTIONS

From the Terminal window, use the comsol command option -np to control the 
number of cores and processors used. The default is to use all available cores and 
processors. For example:

comsol -np 2

launches COMSOL Multiphysics using 2 cores (if available).
You might need to experiment to find the options that work best for your 
configuration. For more information see the COMSOL Multiphysics Reference 
Manual.

Running COMSOL Multiphysics in Batch Mode

You can submit COMSOL Multiphysics batch jobs from the COMSOL Desktop 
and the command line. 
To run a COMSOL Multiphysics batch job from the COMSOL Desktop, you 
need to make the Batch feature visible: in the Model Builder tree, click the Show 
button ( ) and select Advanced Study Options. In the Model Builder, right-click 
a Study node and select Batch to create batch jobs.
From a terminal window, you can start batch jobs using the comsol batch 
command. This is an example of such a command:

comsol batch -inputfile in.mph -outputfile out.mph

To run a specific study add the command line option -study <tag>, where <tag> 
is the tag of the study to run, for instance, std1. To see the tag, click the toolbar 
button Model Tree Node Text in the Model Builder and select Tag.
The COMSOL Multiphysics Reference Manual has a dedicated section on 
running COMSOL Multiphysics from a terminal window, including a list of 
COMSOL commands and associated syntax.
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Running COMSOL Multiphysics in Client-Server Mode

When you start COMSOL Multiphysics by, for example, entering the comsol 
command with no additional arguments, COMSOL Multiphysics is run as a single 
application that includes the functionality of both the COMSOL Multiphysics 
Client and COMSOL Multiphysics Server, as explained later in this section. 
However, the COMSOL client-server architecture lets you access the COMSOL 
Multiphysics Server — the COMSOL computational engine — as a separate 
process. For example, the COMSOL Desktop can act as a COMSOL Multiphysics 
Client when connected to a COMSOL Multiphysics Server.

You need a Floating Network License to run the COMSOL Multiphysics Server 
and the COMSOL Multiphysics Client on separate computers. However, any 
COMSOL license is sufficient for running the Client and the Server on the same 
computer.
The Client and Server need not run on the same platform. For example, you can 
run the COMSOL Desktop on Windows connecting to a COMSOL Multiphysics 
Server on a Linux computer. This enables offloading heavy-duty computations 
from your personal laptop or desktop to run just the COMSOL Desktop graphical 
user interface. A typical use would be to run the COMSOL Multiphysics Server 
on a computer with large amounts of memory (RAM) and processing power and 
to use your personal computer for pre- and postprocessing with the COMSOL 
Desktop. 

STARTING A COMSOL MULTIPHYSICS SERVER

To start the COMSOL Multiphysics Server from a terminal window, run the 
comsol command with the mphserver argument:

comsol mphserver

You are then prompted for a username and password. You can use any username 
and password of your choice, it is only used for connecting a COMSOL 
Multiphysics Client with a COMSOL Multiphysics Server.
When the COMSOL Multiphysics Server starts, it listens for a COMSOL 
Multiphysics Client connection on the port listed in the command window.

The license server is not the same as a COMSOL Multiphysics 
Server. The license manager can run on a computer different from 
both the ones used by COMSOL Desktop and COMSOL 
Multiphysics Server.
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Connecting a COMSOL Multiphysics Client to a COMSOL Multiphysics Server
You can start a COMSOL Multiphysics Client session from the COMSOL 
Desktop by selecting Connect to Server from the File menu in the COMSOL 
Desktop. You can also start a COMSOL Multiphysics Client session from a 
terminal window by running the comsol command with the client argument:

comsol client

When you start the Client, a Connect to COMSOL Multiphysics Server window 
appears prompting you for a computer name (Server) where the COMSOL 
Multiphysics Server is running, Port number, Username, and Password:

Once you have filled out this information and clicked OK, the COMSOL 
Multiphysics Server terminal window displays information that a COMSOL 
Multiphysics Client has connected. For more information on running COMSOL 
in Client/Server mode, see the COMSOL Multiphysics Reference Manual.

Running a Classkit License

To start COMSOL Multiphysics using a Classkit License, start COMSOL 
Multiphysics using the -ckl option:

comsol -ckl

Running COMSOL on Clusters

You can launch COMSOL Multiphysics cluster jobs from the COMSOL Desktop 
and the command line.
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To run COMSOL Multiphysics on a cluster from the COMSOL Desktop, you 
need to make the cluster feature visible: in the Model Builder tree, click the Show 
button ( ) and select Advanced Study Options. Then in the Model Builder, 
right-click a Study node and select Cluster Computing or Cluster Sweep to create 
cluster jobs. Cluster computing requires a Floating Network License. 
The following terms occur frequently when describing the hardware for cluster 
computing and shared memory parallel computing:
• Compute node: The compute nodes are where the distributed computing 

occurs. Each distributed COMSOL process resides in a compute node and 
communicates with other compute nodes using MPI (message-passing 
interface).

• Host: The host is a physical machine (hardware) with a network adapter and 
unique network address. The host is part of the cluster. It is sometimes 
referred to as a physical node.

• Core: The core is a processor core used in shared-memory parallelism by a 
computational node with multiple processors.

The number of used hosts and the number of computational nodes are usually the 
same. For some special simulation types, like very small simulations with many 
parameters, it might be beneficial to use more than one computational node on 
one host.
A tutorial model for cluster testing is included in the Application Libraries window 
under COMSOL Multiphysics>Tutorial models>micromixer_cluster.

QUICK TROUBLESHOOTING

• Your first step is to make sure you have the latest release installed. Check that 
you have COMSOL 5.3 or later and make sure to install the latest product 
updates.

• If you get the error message Process status indicates that process is running, 
then cancel any running jobs in the scheduler that you use. In the COMSOL 
Desktop, locate the External Process page at the bottom right. Click the Clear 
Status button.

For more information about how to run COMSOL Multiphysics in parallel on 
Linux clusters, see the COMSOL Multiphysics Reference Manual. For installation 
on Clusters, see Cluster Installation.
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Running COMSOL Multiphysics on the Cloud

COMSOL Multiphysics supports cloud computing using Linux through Amazon 
Elastic Compute Cloud™ (Amazon EC2)™. See Running COMSOL on the 
Amazon Cloud. This PDF can be accessed online: 
www.comsol.com/ec2_manual.

Running COMSOL Multiphysics with MATLAB

Running COMSOL Multiphysics with MATLAB starts a COMSOL Multiphysics 
Server and a MATLAB Desktop. No COMSOL graphical user interface is 
involved. For a tutorial, see the LiveLink for MATLAB User’s Guide.
To launch MATLAB and connect it to a COMSOL Multiphysics Server, run the 
command

comsol mphserver matlab

STARTING COMSOL MULTIPHYSICS WITH MATLAB USING THE GRAPHICS 

SERVER

To display the plot in a COMSOL graphics window you need to run COMSOL 
with MATLAB using the graphics server. To do so, start COMSOL with 
MATLAB from a terminal window with the -graphics flag:

comsol mphserver matlab -graphics

REQUIRED PROGRAMS FOR RUNNING COMSOL WITH MATLAB
The xterm program is necessary for the command comsol mphserver matlab. 
The csh program is needed to call MATLAB functions from COMSOL 
Multiphysics.
• To install the missing packages on Debian and Ubuntu, type

sudo apt-get install xterm csh

• To install the missing packages on RedHat Enterprise and Fedora, type
sudo yum install xterm tcsh

• To install the missing packages on OpenSUSE, type
sudo zypper install xterm tcsh
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Troubleshooting License Errors

If you have questions or problems with your installation, start by checking the 
COMSOL Support Knowledge Base at 
www.comsol.com/support/knowledgebase/ for up-to-date information about 
installation and license issues. If this does not help, then please contact COMSOL 
technical support at support@comsol.com.

THE COMSOL SUPPORT KNOWLEDGE BASE

The most important Knowledge Base entries for installation questions and license 
errors are the following:

You can also view videos about installation at: 
www.comsol.com/video/browse/installation.

LICENSE ERRORS

This section summarizes the most common post-installation error messages 
generated by COMSOL, and it gives some advice how to troubleshoot them. For 
a complete list of error messages, see the FlexNet license manager documentation. 
This documentation is shipped with your COMSOL installation; see FlexNet® 
License Manager Documentation on where to find it.

SUBJECT KNOWLEDGE BASE ENTRY

Could not obtain license for 
COMSOL Multiphysics GUI

www.comsol.com/support/knowledgebase/903

Running COMSOL in parallel 
on clusters

www.comsol.com/support/knowledgebase/1001

Updating the COMSOL 
License Manager

www.comsol.com/support/knowledgebase/1022

COMSOL Installation 
Companion

www.comsol.com/support/knowledgebase/1077

Error: An error has occurred. 
See the log file C:\Users...

www.comsol.com/support/knowledgebase/1083

Selecting hardware for 
clusters

www.comsol.com/support/knowledgebase/1116

Error: Error downloading file. 
Connection refused: connect

www.comsol.com/support/knowledgebase/1149
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If you need to review the license manager log file, or send it to COMSOL 
technical support, this is where you usually find it (depending on choices you 
made during the installation):
• Windows: C:\Program Files\COMSOL53\Multiphysics\license\comsol53.log 

or C:\comsol.log.
• macOS: /var/tmp/comsol53.log
• Linux: /var/tmp/comsol53.log

If you need to access the license file, this is where you usually find it:
• Windows: C:\Program Files\COMSOL53\Multiphysics\license\license.dat
• macOS: /Applications/COMSOL53/Multiphysics/license/license.dat
• Linux: /usr/local/comsol53/multiphysics/license/license.dat

ERROR MESSAGE EXPLANATION

License error A general license error has occurred. Check the error message for 
details that might help solve the problem. If you need help in 
interpreting the information, see the FlexNet License Manager 
documentation or send the complete error message to 
support@comsol.com.

License error : -1. 
Cannot find license 
file.

The license file is missing or your system settings don’t allow you to 
read the file. Review the license manager installation steps above and 
check that you have administrative rights on your computer.

License error : -2. 
Invalid license file 
syntax.

There is a formatting problem with your license file. This can happen if 
you edit it with a word processing software such as Microsoft Word 
which inserts extra (invisible) characters. Use a plain text editor 
instead (on Windows: Notepad, WordPad, or similar). Formatting 
problems can also happen if the file is corrupted while being copied 
or emailed from one computer to another.

License error : -4. 
Licensed number 
of users already 
reached.

The license manager has detected that all available licenses of a 
certain COMSOL product have been used by other users. Contact 
your license administrator and report this problem. You might need 
more licenses of one of the add-on products.

License error : -5. 
No such feature 
exists.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages.

Please send the log file to support@comsol.com if you want help in 
interpreting the information.

NOTE: The license manager creates the log file. If there is no log file, 
make sure to first start the license manager. Please refer to one of the 
License Manager Installation sections of this manual for instructions 
how to install and start the COMSOL license manager.
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License error : -10. 
Feature has 
expired.

This error message indicates that you have a time-limited (trial) license 
and that your license has expired. Contact your license administrator 
to see if a more recent license file is available. You can also contact a 
COMSOL representative to renew your time-limited license.

License error : -12. 
Invalid returned 
data from license 
server system.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if that 
helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager, or the connection from the lmgrd daemon and the 
LMCOMSOL daemon.

If the problems remain, send the license manager log file to 
support@comsol.com.

ERROR MESSAGE EXPLANATION
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License error : -15. 
Cannot connect to 
license server 
system.

The COMSOL license manager has not been installed or started yet. 
If the first line of your license.dat file looks like this:

SERVER mylicserver 000123456789 1718

a license manager is required. Please refer to the License Manager 
Installation sections of this manual for instructions on how to install 
and start the COMSOL license manager.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if that 
helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager.

Check that the license.dat file on the COMSOL client computer 
points to the correct license server host name. First, find the 
license.dat according to the instructions above.

Check that the first line has the correct license server Host Name. 
For example, if your license server Host Name is apollo, the first 
row in the license.dat file should look like this:

SERVER apollo 000123456789 1718

If the COMSOL client computer does not recognize apollo as a 
proper Host Name, it might help to instead use the fully qualified 
domain name (apollo.thecompany.com) or the IP address. If 
neither of these work, there might be a problem with DNS or the 
HOSTS file on the client. Please ask your system administrator for 
advice on how to connect with TCP/IP to the license server.

Finally, the license manager might have encountered a problem during 
startup. Check the license manager log file for error messages.

NOTE: The log file is created by the license manager after it has been 
started.

Please send the log file to support@comsol.com if you want help in 
interpreting the information.

License error : -39. 
User/host not on 
INCLUDE list for 
feature.

The error means that your username does not match the one listed in 
the license-manager options file, LMCOMSOL.opt. To get access to 
COMSOL, ask your license/system administrator for help. When the 
username in the options file is changed, the license manager must be 
shut down and restarted to give the new user immediate access to 
COMSOL. 

ERROR MESSAGE EXPLANATION
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License error : -88. 
System clock has 
been set back.

The software has detected that a system clock has been set back.

Please make sure that your computer’s clock is set to the current local 
time and date. If the problem remains check that there are no files on 
your hard drive that have a future date.

License error : -96. 
License server 
machine is down 
or not responding.

Please make sure that the SERVER host name in the license.dat 
file is valid and that the TCP/IP network connection between the 
application computer and the license server is working properly.

This error could also indicate that your firewall is not configured 
properly in order to let the license manager and vendor daemon 
network traffic through (typically ports 1718 and 1719). It could also 
indicate problems with other network security settings. Contact your 
systems administrator for help.

License error : -97. 
The desired 
vendor daemon is 
down.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages.

NOTE: The log file is created by the license manager after it has been 
started.

Please send the log file to support@comsol.com if you want help in 
interpreting the information. 

ERROR MESSAGE EXPLANATION
 | 115



116 | 



Index 

A add feature 22

application libraries, installing 26

Application Library Update

configuring on Linux 95

configuring on macOS 75

configuring on Windows 42

AutoCAD

LiveLink for 45

Autodesk Inventor

LiveLink for 44

automated installation

Linux 94

macOS 75

Windows 41

automated license manager installation

Linux license server 101

macOS license server 79

Windows license server 56

B boot script 102

Bourne shell commands 101

browser, Linux file 94

C change license, with COMSOL installer 

22

changing the license

Linux 103

macOS 81

Windows 59

Classkit License

desktop shortcuts 63

Linux 108

macOS 84

Windows 62

cluster computing

Linux 109

macOS 88

Windows 67

comment line, license file 52

Community Discussion Forum 15

compute node 68

COMSOL Access 15

COMSOL Client

macOS 85

Windows, connecting 65

comsol command, Linux 105

comsol command, macOS 84

COMSOL Conference 15

COMSOL Exchange 15

COMSOL Multiphysics Client

Linux, connecting 108

macOS, connecting 85

Windows 62

Windows, running 64

COMSOL Multiphysics Server

Linux, running 107

Linux, running with MATLAB 110

Linux, starting 107

macOS 83

macOS, running 84

macOS, starting 85

Windows 62

Windows, running 64

Windows, running with MATLAB 69

COMSOL Software License Agree-

ment 11

COMSOL Video Center 9

core 68

CPU-Locked Single User License 12

Creo Parametric

LiveLink for 46

cross-platform user interface 61, 63

csh program 110
 | 117



D DirectX runtime binaries 30

documentation, installing 26

dongle 14

downloading product 9

macOS 70

macOS, DVD 73, 91

troubleshooting 111

Windows 16

Windows, DVD 19

E errors, license 111

Ethernet address

Linux 89

macOS 82

Windows 17

Windows, changing license and 59

F FEATURE line, license file 53

FEATURE names 53

FlexNet

control panel 50

License Administration Guide, Linux 

98

License Administration Guide, ma-

cOS 77

License Administration Guide, Win-

dows 51

license manager, troubleshooting 111

license manager, Windows 49

management, Linux 98

management, macOS 77

management, Windows 50

utility program, Linux 98

utility program, macOS 77

utility program, Windows 50

Floating Network License

definition 12

Linux, client servers and 107

Linux, clusters and 109

Linux, clusters installation and 96

macOS, client server and 85

macOS, clusters and 88

management software 14

Windows, client server and 64

Windows, cluster installation and 48

Windows, clusters and 67

Windows, definition 49

H hard disk serial number 17

hardware address 71

hardware lock 14

host 68

hostid

Linux, changing licenses 104

Linux, Internet installations 89

macOS, changing licenses 82

macOS, Internet installations 71

Windows, changing licenses 59

Windows, Internet installations 17

Windows, license server and 52

I INCREMENT line, license file 53

installation

Linux 89

macOS 70

media options 9

previous 10

Windows 16

installation, quick selections 26

K Knowledge Base 9

COMSOL Access, and 15

troubleshooting 111

L License Agreement 9

license agreement 11

license errors 111

license file

comment line 52

FEATURE line 53

FlexNet, and 14

INCREMENT line 53
118 | 



macOS, obtaining 72

SERIAL line 53

SERVER line 52

troubleshooting 112

USE_SERVER line 52

VENDOR line 52

Windows, obtaining 18

license manager

automated installation on Linux 101

automated installation on macOS 79

automated installation on Windows 

56

daemon, Linux 98

daemon, macOS 77

daemon, Windows 50

files for installation, Linux 99

files for installation, macOS 78

files for installation, Windows 55

installing files, Linux 99

installing files, macOS 78

installing files, Windows 55

Linux, log file 101

Linux, starting 101

log file 58

log file, troubleshooting 112

macOS, log file 80

macOS, starting 80

Windows, log file 58

Windows, starting 57

license server

Linux, and 98

Linux, client server and 107

macOS, and 77

Windows, and 24

Windows, client server and 64

license, changing

Linux 103

macOS 81

Windows 59

license.dat

FlexNet, and 14

Linux 99

Linux, changing 103

macOS 77

macOS, changing 81

troubleshooting 112

Windows 51

Windows, FlexNet and 50

Linux Standard Base 104

LiveLink for

AutoCAD 45

Autodesk Inventor 44

Creo Parametric 46

Pro/ENGINEER 45

Solid Edge 47

SolidWorks 43

lmgrd.exe Linux 98

lmgrd.exe macOS 77

lmgrd.exe Windows 50

lmhostid

Linux 104

macOS 82

lmutil

Windows 59

lmutil Linux 98

lmutil macOS 77

lmutil Windows 50

log file, license manager 58

log file, Linux 101

log file, macOS 80

log file, troubleshooting 112

log file, Windows 58

LSB 104

M MAC address

Linux installations 89

macOS installations 82

Windows installations 17, 59

MATLAB
 | 119



Linux, changing path to 96

macOS, changing path to 76

running COMSOL Multiphysics on 

Linux with 110

running COMSOL Multiphysics on 

macOS with 83

running COMSOL Multiphysics on 

Windows with 69

Windows, changing path to 69

merged license file 25

multicore computing 12

multiprocessor computing 12

N Named Single User License

definition 12

Linux, and 93, 99

O operating system 11

options file 99

P passcode 16

physical address 17

port number 24

previous installation 10

Pro/ENGINEER

LiveLink for 45

product downloads 9

COMSOL Access, and 15

macOS 70

macOS, DVD 73, 91

troubleshooting 111

Windows 16

Windows, DVD 19

product updates 9

COMSOL Access, and 15

proxy server

for software updates 41

Linux installations 95

macOS installations 76

Windows installations 31

Q quick selections, for installation 26

R Remote Desktop 30

remove feature 22

root 101

S SERIAL line, license file 53

SERVER line, license file 52

shared-memory computing 12

software license agreement 11

Solid Edge

LiveLink for 47

SolidWorks

LiveLink for 43

system requirements 9, 10

T technical support, contacting 111

technical support, website 9

three-server redundancy 24

trial license

Linux 89

macOS 70

Windows 16

troubleshooting license errors 111

tutorials, installation 111

tutorials, videos 9

U uninstalling COMSOL

Linux 94

macOS 75

Windows 39

updates, product 9

COMSOL Access 15

USE_SERVER line, license file 52

user interface, cross-platform 61, 63

utility program, Linux 98

utility program, macOS 77

utility program, Windows 50

V vendor daemon

Linux installations 98

macOS installations 77

Windows installations 50

VENDOR line, license file 52
120 | 



videos

installation 111

tutorials 9

volume serial number 17

W web browsers, for Linux 94

Windows Remote Desktop 30

X xterm program 110
 | 121



122 | 


	Contents
	Before you Begin
	Installation Media Options
	System Requirements
	Previous Installations
	Software License Agreement
	License Types
	License Management Tools
	COMSOL Access

	Installing on Windows
	Installation over the Internet
	Downloading and Installing the COMSOL Software
	Installation from a USB Flash Drive
	Running the COMSOL Installer
	Removing (Uninstalling) the COMSOL Installation
	Installing Software Updates
	Automated Installation
	Product Updates and Library Updates
	LiveLink™ for Excel® Installations
	LiveLink™ for SOLIDWORKS®: Add-In for SOLIDWORKS
	LiveLink™ for Inventor®: Add-in for Autodesk Inventor
	LiveLink™ for AutoCAD® Installations
	LiveLink™ for PTC® Pro/ENGINEER®: Changing the Installation Path
	LiveLink™ for PTC® Creo® Parametric™: Add-in for PTC Creo Parametric
	LiveLink™ for Revit®: Add-in for Revit
	LiveLink™ for Solid Edge®: Add-in for Solid Edge
	Cluster Installation

	License Manager Installation on Windows
	What is the FlexNet® License Manager?
	System Requirements for the FlexNet® License Manager
	FlexNet® License Manager Software Components
	FlexNet® License Manager Documentation
	The License File
	Installing the License Manager
	Starting the License Manager
	Verifying that the License Manager is Running
	Starting COMSOL Multiphysics
	Changing the License
	Troubleshooting License Errors

	Running COMSOL Multiphysics on Windows
	The COMSOL Multiphysics Folder on The Start Menu
	Starting COMSOL Multiphysics for a Classkit License
	Creating Desktop Shortcuts Manually
	Running COMSOL Multiphysics in Client-Server Mode
	Running COMSOL Multiphysics in Batch Mode
	Multicore Settings
	Running COMSOL Multiphysics on Clusters
	Running COMSOL Multiphysics on the Cloud
	Running COMSOL Multiphysics with MATLAB

	Installing on macOS
	Installation Over the Internet
	Downloading and Installing the COMSOL Software
	Installation from USB Flash Drive
	Running The COMSOL Installer
	Automated Installation
	Removing (Uninstalling) the COMSOL Installation
	Product Updates and Application Library Update
	Changing the Path to the MATLAB® Installation

	License Manager Installation on macOS
	FlexNet License Manager Software Components
	FlexNet License Manager Documentation
	The License File
	Installing the License Manager
	Starting the License Manager
	Verifying that the License Manager is Running
	Starting COMSOL Multiphysics
	Changing the License
	Troubleshooting License Errors

	Running COMSOL Multiphysics on macOS
	The COMSOL Applications
	Running COMSOL Multiphysics from a Terminal Window
	Running a Classkit License
	Running COMSOL Multiphysics in Client-Server Mode
	Running COMSOL Multiphysics in Batch Mode
	Multicore Settings
	Running COMSOL Multiphysics on Clusters
	Running COMSOL Multiphysics on the Cloud

	Installing on Linux
	Installation Over the Internet
	Downloading and Installing the COMSOL Software
	Installing from a DVD
	Installation from USB Flash Drive
	Running The COMSOL Installer
	Web Browser for Viewing the Documentation
	Automated Installation
	Removing (Uninstalling) the COMSOL Installation
	Product Updates and Application Library Update
	Changing the Path to the MATLAB® Installation
	Cluster Installation

	License Manager Installation on Linux
	FlexNet License Manager Software Components
	FlexNet License Manager Documentation
	The License File
	Installing the License Manager
	Starting the License Manager
	Verifying that the License Manager is Running
	Starting COMSOL Multiphysics
	Changing the License
	Troubleshooting License Errors

	Running COMSOL Multiphysics on Linux
	Running COMSOL Multiphysics
	Multicore Settings
	Running COMSOL Multiphysics in Batch Mode
	Running COMSOL Multiphysics in Client-Server Mode
	Running a Classkit License
	Running COMSOL on Clusters
	Running COMSOL Multiphysics on the Cloud
	Running COMSOL Multiphysics with MATLAB

	Troubleshooting License Errors

